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Reé-dve

Gotovo 90% korisnika OS Windows ima instaliran programski paket Microsoft Office, pa je ovo za pocetak sasvim
dovoljno da ukaZe na njegovu populamnost. Iako je pocetna ideja Microsoft-a bila "softver za kancelarijsko poslova-
nje", Microsoft Office programi su brzo napredovali i nasli primenu i u mnogim drugim delatnostima. Pored toga u
ovim programima svako mo¥e pronaéi nesto za sebe, od tekst procesora, preko grafi¢kih dodataka, programa za izra-
du animiranih prezentacija, programa za tabelarne prorac¢une, programa za planiranje i organizovanje, pa sve do pro-
grama za projektovanje baza podataka i povezivanja svih pomenutih u jedan projekat.
Okosnica Microsoft Office paketa su programi:
MS Word  tekst procesor,
MS Excel program za tabelarne i statisticke proracune,
MS PowerPoint  program za izradu prezentacija,
MS Outlook sistem za vodenje planera, podsetnika, adresara, kontakata,...
MS Access program za razvijanje i kori§¢enje baza podataka,
MS Binder ima moguénost da datoteke pomenutih programa poveZe u jednu celinu.

Opisane teme su primenjive na verziju MS Office-a 97 Professional i MS Office 2000 - Premium, a instalacione verzi-
jeoba paketa se isporucuje na CD-u i pored pomenutih glavnih programa sadrfe i mnoge dodatke, koji se opciono
mogu izabrati za instaliranje, pa va¥e na nivou celog paketa, i to:

MS Office Shortcut Bar sistem za organizovanje precica,
MS Find Fast program za indeksirano pronalaZenje datoteka na disku,
MS PhotoEditor program za obradu bitmap grafic¢kih formata,
MS Map alat za obradu geopolitickih karata,
MS Graph ugradnju statisti¢kog grafikona u bilo koji Microsoft Office program,
Drawing i WordAnt  izradu specifi¢nih grafickih objekata na najjednostavniji nacin,
MS Organization Chart  izradu organizacionih $ema,
MS Query kreiranje upita na izvor podataka (najcesée MS Access baze),
MS Equation dizajn matemati¢kih obrazaca,
Auto Correct automatizovano korigovanje pri unosu teksta,
Spelling & Grammar za kontrolu i korigovanje pravopisa, podelu rec¢i na slogove i sl.

Navedeni dodaci funkcioni$u kao deljeni resursi paketa, pa tako na primer: re¢, uvedena za korigovanje (AutoCor-
rect) pri radu u MS Word-u biée na raspolaganju i u MS Excel-u i u MS Access-u,... naravno sa ne$to druga&ijim po-
defavanjem njegovog kori§¢enja, jer je koncept svakog od ovih programa specifi¢an.

Skripta, u vasim rukama, je pisana na takav nac¢in da vam obezbedi savladavanje "osnovnih" alata u programima MS
Word i MS Excel, ali imajte na umu da je predavac pred vama (a ne skripta) — klju¢na karika vase dobre edukacije.

Teme obeletene @ znakom su sastavni deo Osnovnog kursa, pa ¢e ovde biti samo implementirane, a krajnje je vre-

me da ih savladate da biste se na najbolji nadin uklju&ili u rad ovog kursa. Teme obelezene @ znakom nisu obavez-
ne za obradu na predavanjima, veé ¢e ovde biti samo pomenute da biste stekli potpuniju sliku 0 moguénostima ovih
programa. One se obraduju na Master kursu MS Word + MS Excel, jer su nesto kompleksnije, pa traZe viSe vremena
za savladavanje.

Ovde je prikazana verzija Microsoft Office 2000, ali na taj na¢in da korisnicima verzije 97 nece biti problem da prate
gradivo. Nadamo se da cete biti zadovoljni nasim izborom tema za ovaj kurs i sadrZajem skripta, ali smo spremni i da
svim vasim pojedina¢nim zahtevima izademo u susret, sve dok se oni uklapaju u naSe opste principe.

Unapred se zahvaljujem svima koji mi uka?u na greske ili upute sugestije, li¢no ili na e-mail: Mikac(@BitsYu.net

Zabranjeno je svako umnozavanje i kori$¢enje
delova ove publikacije bez odobrenja autora.

autor







R S. Mikanovié

1] MS Word
Uvod u MS Word

STA MOZE?

Savremeno poslovanje danas namece sve veée zahteve u pogledu brzog, jednostavnog i automatizovanog kreiranja
razlicitih vrsta dokumenata. MS Word dr#i visok rejting u klasi programa za obradu teksta i esto se pominje kao
najbolji, najjednosta

vniji, ali i pored svoje jednostavnosti, kao program sa velikim moguénostima u pogledu automatizovanog kreiranja i
formatizovanja dokumenata. MS Word ima §iroku paletu komandi i opcionih pode$avanja koje se na prvi pogled ne
vide (da se korisnik ne bi izgubio u "$§umi" moguénosti), ali je njihovo uklju¢ivanje u radno okruzenje vrlo lako i jed-
nostavno.

Kada se neki program toliko dugo i naSiroko koristi onda je sigurno da su mu i moguénosti velike, pa je odabir naj-
vaznijih (neophodnih) tema, za autora, vrlo teZak zadatak. Kroz, ovde odabrane, teme prikazane samo neke od mo-
guénosti ova dva programa, a teZnja je data na njihovu primenu u kancelarijskim poslovima.

Uzeti za obradu samo neke teme ovako obimnog programa sigurno nije zahvalno, ali to se veé par godina nameée
kao ozbiljan problem u edukaciji korisnika savremenog softvera. Mi ¢emo vas uvesti u osnove MS Word-a, ali istov-
remeno pokusati i da vas podstaknemo da koristite i neke njegove automatizme, neophodne i izuzetno korisne u
kancelarijskim i sli¢nim poslovima. Bilo da ste veé radili u Word-u ili ne, va$a produktivnost u ovom programu ée se
u mnogome povedati, pa ¢ete tako uraditi za 30-ak minuta posao koji ste nekada obavljali danima.

GOtOVO da nema §tampano teksta kOl nije obradivan u ovom programu, barem u poéetku SVO "stvaran'a”, pa dal'e
prolazio razne obhke import/ export "trauma".

A KoMSILUK?

Ve¢ niz godina su opticaju mnogi programi za obradu teksta (tekst procesori) iz kojih su se pored MS Word-a izdvojili
Word Perfect, Corel WordPerfect, Lotus AmiPro i TEX kao specifi¢an oblik obrade teksta kompajliranjem. Da nas po-
jedinacna diskusija svih programa ove klase ne bi odvela daleko, dovoljno je reéi da svaki od ovih programa ima
svoje prednosti nad ostalima, ali se generalno krug korisnika MS Word-a svakim danom povecava na ratun pome-
nutih.

Radno okruzenje

NACINI ULASKA U MS WORD

Klasi¢an ulazak u MS Word se izvodi preko start menija (Start» Program» Microsoft Word) ili preko precice na Desk-
top-u, ¢ime se u programu dobija ¢ist novi dokument prema postavljenim podrazumevanim opcijama (Sablon Nor-
mal.dot). Ako korisnik ima razvijene $ablone za dokumente koje najéesce kreira (dopisi, pisma, uverenja, izvestaj,
racuni, fax poruke,...i sl.), savetuje se da novi Word dokument otvara prema nekom raspoloZivom $ablonu i to na
Start» New Office Document», gde su mu uobicajeno na raspolaganju $abloni za sve programe Microsoft Office-a i to
oni koje je instaliranjem dobio.

Jedan od najpopularnijih nac¢ina zapocinjanja rada na ¢istom novom Word dokumentu (primenljivo u veéini sta-
ndardnih Windows programa), kod onih koji dobro vladaju tehnikom rada u Windows Explorer-u, je sli¢an postupku
kreiranja novog Folder-a: desni klik mifem na lokaciju gde treba kreirati dokument, pa na New» Microsoft Word Do-
cument. Posle ovoga, dokumentu treba jo§ dodeliti i ime, pa po potrebi otvoriti na jedan od uobi¢ajenih nac¢ina otva-
ranja objekta (dvostruki klik miSem ili <Enter>).

PrRoDUZENI MDI

MS Word nudi rad u tzv. MDI (Multi Document Interface) okruZenju, gde prozor aplikacije okuplja i kontrolife sve
prozore dokumenata, pa se tako uocavaju dva ClipBox-a za upravljanje veli¢inom prozora (u gornjem desnom uglu).
Za lak3e snalaZenje i manje dilema treba uociti da je prozor aplikacije uvek veéi i zadrzava u sebi prozore dokumena-
ta, kojih naravno moZe biti vise. Word 2000 nudi tastere svih aktivnih dokumenata i na Toolbar-u, kao zasebne apli-
kacije (3to moZe izazvati utisak da je Word otvoren viSe puta, ali nije tako).

Svaki prozor u naslovnoj liniji nosi ime dokumenta koji se u njemu obraduje, a u slu¢aju da je prozor dokumenta
maksimiziran ovo se prenosi kao dodatak u naslovnu liniju prozora Word-a. Zatvoriti dokument znadi zatvoriti nje-
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gov prozor, a zatvoriti MS Word znaci zatvoriti glavni prozor aplikacije (vi$e o upravljanju dokumentima u narednim
lekcijama).

ALATI PRISTUPACNI KRO Z PALETE

Koncepcija jednostavnog i prilagodljivog grafickog radnog okruZzenja u MS Word-u, kao i u ostalim Microsoft Office
programima, zasnovana je na paletama alata (Toolbars), gde je korisniku dato na raspolaganje da sam podesi okruZe-
nje u kome radi i da sve ono §to Cesto koristi postavi kao vidljivo i pri ruci, a ono §to mu nije potrebno - ukloni. Po-
deSavanje se zasniva na ukljucenju (isklju¢enju) paleta, kao i dodavanju (uklanjanju) alatki u njima. Svaka alatka je
grafi¢ki predstavljena u obliku komandnog dugmeta sa ikonicom, a njegovo kori§éenje je omoguéeno i preko tasta-
ture.

Rad na podes$avanju okruZenja je apsolutno bezbedan i ne moZe ugroziti rad u programu, $to ¢emo prakti¢no isproba-
ti, a na ovom mestu samo navesti i opisati osnovne palete:

PALETA | OPIS

Menu Bar | je glavna i jedina paleta (uslovno re¢eno) koja ne moZe da se ukloni (ali moZe da se uredu-
ie), pa kako je istovremeno i meni linija, njenim se zatvaranjem ustvari zatvara samo teku-
¢i dokument. Savetuje se da korisnik ovu paletu ostavi u vrhu prozora, da bi se lakse
prilagodio drugim Windows programima sa meni linijom fiksiranom na istom mestu.

Standard | je paleta u kojoj su smeSteni standardni najce$¢i alati, kao $to su:

New - kreiranje novog dokumenta,

Open - otvaranje postoje¢eg dokumenta,

Print Preview - pogled na dokument o obliku za §tampanje,
alati azuriranja - Cut, Copy, Paste, Undo, Redo

alati pregleda - Document Map, Show/Hide Paragraph, Zoom

Formatting | paleta sadr?i najcesce alate koji se koriste u cilju formatizovanja i to:
Style - za primenu definisanog stila,
Font - za primenu nekog od raspoloZivih fontova na selektovani tekst
Font Size - za definisanje velicine fonta,
BIU - zaprimenu masnog, kurziv ili podvucenog stila fonta,
poravnanje pasusa - oblici poravnanja Left, Center, Right i Justify,
nabrajanja - progresivno (1,2,3 ili a,b,c) ili fiksno (simbolima),
uvlacenja - uvlalenje i izvladenje pasusa,
Borders - definisanje iscrtavanja granica (uglavnom za tabele, a rede za tekst)
Highlight - signir za naglasavanje delova teksta (bojenjem pozadine teksta),
Font Color - zadavanje boje karaktera (znakova) u tekstu.

Neke palete (Tables and Borders, Drawing,...) se mogu ukljuciti na odgovarajucu ikonicu u Standard paleti, a neke se
mogu izdvojiti iz svojih ikonica pa daju sve moguénosti u jednom malom prozoru (Borders, Font Color, Shading Co-
lor,...).

Pri koris¢enju klika mifem na dugme alata (akcije) treba uociti da neka dugmad imaju moguénost otvaranja palete
sa ponudom izbora, koja se otvara na strelicu sa desne strane dugmeta, dok se direktnim klikom na dugme potvrduje
tekudi status (obi¢no prethodno obavljena akcija sa istog dugmeta).
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Navigacija kroz Word dokument

NAVIGACIA

Pod navigacijom se smatra kretanje kroz izvesno ograni¢eno okruZenje. U navigaciji kroz radno okruZenje MS Word-
a je vazno razlikovati prozor dokumenta i prozor aplikacije. Nacini koji ée ovde biti opisani uglavnom se odnose na
navigaciju kroz aktivni dokument, dok ée se neke akcije (samo najc¢esée) odnositi i na navigaciju u prozoru aplikaci-
je. Navigacija se obavlja preko tastature ili miSem, a osnovna razlika medu njima je to §to se kod navigacije miSem
ne podrazumeva i pozicioniranje, §to je slu¢aj kod navigacije preko tastature.

Zbog specifi¢nosti grafickog interfejsa, gde se mnoge akcije tefe obavljaju preko tastature, mi§ se namece kao neop-
hodan uredaj, dok za mnoge napredne akcije nije i dovoljan. Od prekomernog kori§¢enja misa korisnik se cesto "zas-
lepljuje" i zaboravlja da I TASTATURU ima na raspolaganju. Napredna navigacija podrazumeva kori$éenje
ravnopravno oba uredaja i nameée potrebu njihove §to bolje sinhronizacije.

Dakle, koristite oba ova uredaja ravnopravnoi ne potcenjujte moguénosti nijednog.

NAVIGACIJA PREKO TASTATURE

Tasterske kombinacije za kretanje krog dokument:

ZA pozicioniranje u | PRITISNI ZA pozicioniranje u | PRITISNI
jedno mesto udesno | = jednu ¢eliju udesno (u | Tab
tabeli)
jedno mesto ulevo | € jednu éeliju ulevo (u tabeli) | Shift+Tab
jednu liniju nagore | P vrh vidljivog ekrana | Alt4+Ctrl+Page Up
jednu liniju nadole | W dno vidljivog ekrana | Alt+Ctrl+Page
Down
jednu re¢ udesno | Cl+-> prohodni ekran | Page Up
jednu rec ulevo | Ctul+€ slededi ekran | Page Down
jedan pasus nagore | Ctrl+ vrh prethodne strane | Ctrl+ Page Up
jedan pasus nadole | Ctrl+\ vrh sledeée strane | Ctrl+ Page Down
pocetak reda | Home pocetak dokumenta | Ctrl + Home
kraj reda | End kraj dokumenta | Ctrl+ End
NAVIGACIJA MISEM

Ono $to navigaciju miSem &ini interesantnom je to da na svako mesto radnog okruZenja dolazite relativno brzo i na
isti na¢in (pomeranjem i pozicioniranjem). Pored moguénosti pode§avanja oblika pregleda i zumiranja, ¢esto (goto-
vo uvek) korisnik ima potrebu da pogleda deo dokumenta koji se, u odnosu na tekucu poziciju, nalazi: nadole, nago-
re, ulevo ili udesno, a trenutno nije vidljiv. Ako pri tom korisnik Zeli samo pogled (a ne i pozicioniranje) dovoljno je
da iskoristi:
e horizontalni kliza& (ScrollBar u dnu prozora dokumenta) ili
o vertikalne kliza¢ (na desnoj strani prozora dokumenta),
dok je za pozicioniranje jo§ potrebno i kliknuti miSem na (vidljivu) Zeljenu poziciju.
MS Word je medu prvim programima ponudio moguénost navigacije preko Object Browser-a, odnosno po odabra-
nom tipu objekta. Object Browser je smesten u donjem produZetku vertikalnog ScrollBar-a i &ine ga tri tastera:
e srednji (uobliku kuglice)
koji sluZi za odabir tipa objekta i
e gornjii donji
(u obliku dvostrukih strelica)
preko kojih se odlazi na prethodni, odnosno sledeéi objekat u dokumentu (kao na slici).
Klikom na srednji taster dobija se grafi¢ki okvir (kao na sledecoj slici) na kojem se (klikom miSem) odabira tip obje-
kta koji se traZi.

Ako je odabran tip (Page se podrazumeva) objekta koji se traZi strelice na gornjem i donjem tasteru ée biti
obojene u plavo, "kao" na slici:
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STATUSBAR - STATUSNA LINIJA

U samom dnu prozora aplikacije nalazi se statusna linija na kojoj se prikazuje trenutna pozicija u dokumentu, i to u
obliku: poruka, broj tekuce strane i sekcije, udaljenost od gornje margine, tekuca linija i kolona. Nastavak statusne
linije je rezervisan za signaliziranje statusa mnogih servisa kao §to su snimanje makroa, prikazivanje promena kroz
dokument i sl.

Dvostrukim klikom u prvi segment statusne liniji poziva se Go To servis (preko tastature na F5 ili <Ctrl>+G), koji
sluzi za br#i odlazak na neki deo dokumenta, gde preko specifi¢nog dijaloga (prosirenog Find/Replace dijaloga) koris-
nik bira tip objekta (stranu, sekciju, liniju, fusnotu, tabelu, graficki objekat, matematic¢ki obrazac,...) i njegov redni
broj (ili ime).

PADAJUCI MENIJI

Padaju¢i meniji se otvaraju na klik mi§em u potreban meni u meni liniji i izborom neke njegove stavke ili podstavke
(takode klikom), dok se preko tastature svaki od menija moZe otvoriti kombinacijom <Alt> i E g je F podvuceno
slovo u naslovu menija (kao npr. slovo H kod menija Help). Na pritisak tastera <Alt> samo se aktivira prvi meni
(File), pa se omoguéuje kretanje kursorskim strelicama i odabir stavke menija. Stavka se u ovom slu¢aju moZe odab-
rati i pritiskom na taster koji odgovara podvuc¢enom znaku u Zeljenoj stavci. Kada se korisnik nade u odgovarajucoj
stavci menija, odabrati je moZe i pritiskom na taster <Enter>. Za otkaz otvorenih menija i podmenija treba pritisnu-
ti na taster <Esc> i to po jednom za svaki od njih ili samo jednom pritisnuti na taster <Alt>.

Personalizovani meniji u Wordu 2000 prili¢no su zgodni. Oni pamte kori§éene komande i prikazuju samo one koje
ste najée$ée upotrebljavali, naravno i one najosnovnije. Retko primenjivane komande ostaju nevidljive, osim ako
pritisnite prosiriva¢ u dnu svakog menija.

Nazalost, ako otvorite meni pritiskanjem njegovog imena, a onda se nekoliko sekundi dvoumite koju komandu da
upotrebite, Word prikazuje sve komande menija. To automatsko pro$irenje iskljucuje se ovako:

1. Izaberite Tools»Customize, pa u dobijenom dijalogu otvorite karticu Options

2. iskljucite opciju Show full menus after a short delay, pa zatvorite dijalog na Close .

RULERS-LENJIRI

MS Word daje na raspolaganje dva lenjira, i to:
e horizontalni u samom vrhu prozora aktivnog dokumenta i
e vertikalni na levoj strani istog prozora,

a koriste se za neke oblike formatizovanja teksta, kao i orijentaciju i oseéaj za dimenzije, jer je na njima prikazana
centimetarska' podela.

napomene

Podela na lenjirima je zasnovana na mernoj jedinici koja je odabrana Tuals» Options» General» Measurement units

4 MS Word - Navigacija kroz Word d okument
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Selektovanje objekata

NACINI SELEKTOVANJA P REKO TASTATURE

Ako ste isprobali nacine navigacije, selektovanje ¢ée biti vie neko jednostavno. Kada Zelite selektovanje teksta, pot-
rebno je da se pozicionirate na pocetak (ili kraj) zamisljene selekcije, pa na drugi kraj odete na neki od na¢ina navi-
gacije i pri tom drZite pritisnut taster <Shift>. Ceo dokument se moZe selektovati preko tasterske kombinacije
<Cul>+A.

Selektovanje (deselektovanje) od tekuce pozicije:

do pocetka tekuceg reda | Shift+Home
do kraja tekuéeg reda | Shift+End

jedan karakter ulevo | Shift+<
jedan karakter udesno | Shift+->

jednu re ulevo | Ctrl+Shift+ <

jednu re¢ udesno | Ctrl+Shift+->

do pocetka pasusa | Ctrl+Shift+

do kraja pasusa | Ctrl+Shift+\

do pocetka dokumenta | Ctrl+Shift+Home
do kraja dokumenta | Ctrl+Shift+End

NACINI SELEKTOVANJA MISEM

Selektovanje teksta i grafike koriste¢i misa:

ZA SELEKTOVANJE

URADITE

jedne reci

nekog dela teksta
grafi¢kog objekta
(slike)

jedne linije (reda)
vi$e linija teksta

reCenice
pasus
visSe pasusa

celog dokumenta
cele tabele
univerzalno
selektovanje

dvostruki klik na re¢
prevucite misem preko dela teksta uz drzanje levog tastera

kliknite u objekat (sliku)

pomerite misa u prostor ispred prvog karaktera u redu

(dok se pointer miSa ne okrene u desnu stranu) i kliknite.

pomerite miSa u prostor ispred prvog karaktera

(dok se pointer mi$a ne okrene u desnu stranu) i povucite nadole ili nagore
uz drzanje pritisnutog <Ctrl> kliknite bilo gde u re¢enicu

dvostruki klik miSem ispred pasusa ili trostruki klik u pasus

kada ste selektovali jedan pasus, povlatenjem mi$a nadole

ili nagore moZete selektovati susedne pasuse

trostruki klik ispred linije teksta

uz drzanje pritisnutog <Alt>, dvostruki klik u éeliju tabele

pozicionirajte se miSem na pocetak zamisljene selekcije, pa uz drzanje tastera
<Shift>, kliknite mi§em u lokaciju kraja Zeljene selekcije (iskoristite verti-
kalni kliza¢ kada je potrebno da se pozicionirate na neku udaljenu lokaciju u
dokumentu)

Word & Excel - Kurs za poslovne sekretare
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Upravijanje dokumentima

NoOVI DOKUMENT

Pri pokretanju, MS Word odmah nudi novi &ist dokument prema generalnom $ablonu (Normal.dot?). Sva podesava-
nja opcija na default se odnose ba§ na ovaj $ablon (npr. kod Page Setup, Format Font i sl.). Mnogi servisi u MS Word—
u nisu pristupac¢ni dok korisnik ne otvori novi dokument prema ovom (ili bilo kom drugom $ablonu).

Za kreiranje uobicajenog novog dokumenta prema generalnom $ablonu Normal.dot koristi se File»New ili dugme
New (prvo u paleti Standard) sa ikonicom u vidu belog lista papira, dok se za kreiranje novog dokumenta, prema ne-
kom od drugih raspolozivih $ablona, koristi File»New. .. 3,

SNIMAN JE DOKUMENTA
Snimanje dokumenta u MS Word-u se ne razlikuje od iste akcije u drugim® Windows programima.

Treba razlikovati dva pristupa snimanju dokumenta i to:
e  Snimanje dokumenta uz zadavanje neophodnih parametara®:
Ako tekué¢em dokumentu niste dodelili parametre, a pokrenete komandu Save (na <Ctrl>+S
ili File»Save) MS Word ¢e vam dati dijalog "Save As", gde ove parametre treba uneti.
Ako tekudi dokument Zelite sacuvati pod drugim parametrima onda treba pokrenuti Save As
dijalog (kao na slici) preko File»Save As. ..

e Snimanje promena u teku¢em dokumentu:
Da bi promene u dokumentu bile satuvane (aZurirane u fajlu) treba povremeno zadavati
komadu Save (najlakse preko <Ctrl>+S).,
Pri snimanju dokumenta vaino je postovati sledeéa pravila:

1. sauvajte novokreirani dokument veé posle unesena 2-3 pasusa teksta;

2. ne koristite File»Save As..., ako Zelite samo snimanje promena (bez promene parametara Cuvanja),
ved samo precicu <Ctrl>+S na 20-30 minuta ili to prepustite MS Word-u kroz
Save AutoRecover info® servis;

3. dokumente ¢uvajte na, za to predvidenoj, lokaciji (folder) My Documents ili ih organizujte po
temama u vise foldera u istoj;

4. uimenu dokumenta ne koristite specijalne znake ni YU slova, a savetuje se kombinacija velikih i
malih slova bez razmaka (npr: "PrvoPismo");
Ne preterujte sa dufinom imena, jer ime treba da sadr?i samo asocijaciju na sadrfinu dokumenta, a ne i opis
(opis dokumenta se moZe definisati preko na File»Properties), ali i proverite uvek da li dokument ¢uvate u Zeljenom
tipu (formatu), §to moZete videti na "Save as type" u Save As dijalogu), uobicajen tip je "Word Document".

OTVARANJE POSTOJECEG DOKUMENTA

Tek ako ste dokument sacuvali, prilikom njegovog kreiranja, mocicete i da ga otvorite. Otvoriti dokument ne znac&i
kreirati ga, ve¢ pronadi i ucitati u memoriju (RAM) racunara koristeéi neki od raspoloZivih programa (u ovom sluca-
ju MS Word). MS Word za ovo daje standardan dijalog Open kao svim Microsoft Office programima (kao na slici).

Redosled pri otvaranju dokumenta nije deklarisan, ali je prirodno da morate najpre da otvorite lokaciju (folder) na
kojoj se dokument nalazi, pa tek potom otvorite dokument. ComboBox - Look in se koristi za bri pristup nekim uo-
bi¢ajenim lokacijama, kao i Command Bar (sa leve strane dijaloga), koji favorizuje neke najkori$éenije lokacije.
Centralni i najveéi deo dijaloga zauzima folder panel, gde se vide folderi i fajlovi na lokaciji izabranoj preko Look in,

napomene

2 Lokacija generalnog (uohiajenog, podrazumevanog) $ablona za nowWbrd dokument se standardnmalazi u podfolderu{Templates" foldera
gde je instaliranMicrosoft Office (npr: "CA\Program file§Microsoft Offce\TemplatesNormal.dot").

3 s . o . s . 1 . .
Tri tatkice, u stavci menijaili komandnom dugmetu, ztia da ée biti otvoren dijalog ili pokrenut proces iz nekiko koraka.

4 . . . . .
Ovo je rutinska akcija u svim programimaa Windows ®

5 L ) ” . L
Parametri pricuvanju dokumenta su: lokacija (folder), njegovo ime i tip.

6 . o . ) L - )
Detalje prcitajte u nastavku u temi o problemima pri snimanju i otvaranja.

6 MS Word - Upravljanje dokumentima
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a ako se izabere pogled Properties ili Preview,onda se ovaj panel deli na dva dela, pa na desnom delu prikazuje oso-
bine (Properties) izabranog dokumenta ili pogled bez otvaranja (Preview).

Nacin pregleda u ovom panelu, kao i najpotrebniji alati Windows Explorer-a se nalaze na paleti ovog dijaloga (gornji
desni ugao).

Pri ulasku u dijalog Open ili Save As obavezno proditajte tekst u njegovoj naslovnoj liniji.
Pocetnicima (i ne samo njima) se "defava" da umesto Open dijaloga otvore Save As, pa
prazan (&ist dokument) sacuvaju preko postojeceg, ne obaziruéi se na poruku (kao na sli-
ci), gde se odgovor Yes je ovde podrazumevan. Posle ovakve greske postojeéi dokument je
nepovratno izgubljen (i ne pomisljajte na Recycle Bin). Mnogi programi nude podrazume-
vani taster na No, ali to je u MS Word-u taster Yes, $to u kombinaciji sa brzopletim <En-
ter> moZe biti fatalno. Ako i dobijete ovakvu poruku detaljno je razmotrite, a savetuje se
otkaz na Cancel.

Microsoft Word

SAVETI:

1. Da biste otvorili neki dokument koji ste u poslednje vreme obradivali iskoristite stavke u File
meniju koje se nalaze pre stavke Exit, a po¢inju rednim brojevima: 1, 2,... i otvaraju naznacen
dokument.

2. Da biste otvorili vise dokumenata preko jednog dijaloga Open, kada otvorite dijalog, fajlove u
njemu selektujte (drZeéi <Shift> ili <Ctrl>, zavisno od toga da li Zelite selektovanje grupe ili
pojedinacno), pa aktivirajte Open taster ili preko tastature na <Enter>.

3. Radili ste sa nekim tekstom u Word-u, zatvorili ga, a fajl ne mo¥e da se obriSe - stalno dobijate
poruku poput — "Access is denied. Make sure the disk is not full or write-protected". Veéina korisnika
tada resetuje racunar i sve bude u redu. Nema potrebe za tim, sav problem je u Clipboard-u — ako
ste, pre zatvaranja fajla, u Word-u kopirali deo dokumenta na Clipboard, zapravo je na "tablu"
smeSten pointer na segment dokumenta. Dok je pointer tamo, brisanje dokumenta nije mogude.
Umanyjite zauzece Clipboard-a (kopiranjem jednog karaktera) ili zatvorite i ponovo otvorite MS
Word.

4. Ako zelite da Word po startovanju ne ucita nikakav dokument, ¢ak ni prazan, kliknite desnim
tasterom na Shortcut, izaberite Properties» Shortcut, pa liniji kojom se MS Word poziva dodajte
"/n", tako da linija, glasi kao npr.:

"c:\Program files\Microsoft Office\winword\winword.exe /n"

5. Vas Word nece da uc¢itava dokumente koji su stigli od vasih kolega, ili u dokumentima vidite
"brljotine". Poenta je u tome $to su kolege koristile noviju verziju MS Word-a, pa je vreme da je i
vi nabavite. Novije verzije programa nude veée moguénosti i u njima su uglavnom ispravljene
greske iz prethodnih.

KKAKO RAZMESTITI | ORG ANIZOVATI WORD DOKUMENTE

Kako je MS Word prili¢no eksploatisan program, mnogima se dogada da toliko imaju Word dokumenata da posle par
meseci rada na jednom racunaru vise ne znaju gde su koji dokument sac¢uvali. Pored ostalog, na ovaj nadin se prostor
na hard disku nepotrebno zauzima, a sam autor svoje dokumente nalazi najteZe, zatvarajuéi oci pred istinom da —

NESTO NE RADI KAKO TREBA.

Sve vaSe dokumente, koje kreirate iz MS Word-a, smestite u podfoldere jednog foldera. Dobrom organizacijom se
smatra podela po folderima koji nose imena po temama (klijentima ili poslovima) koje ste u njima obavljali. Ako Ze-
lite da saCuvate rezervnu kopiju svog dokumenta — prosto ga sacuvajte (ili iskopirajte preko Windows Explorer-a) u
dodatni podfolder kome éete dati ime npr: PismaREZ, PismaBackup i sli¢no. Za one koji poznaju rad u nekom arhi-

veru (kao §to je. WinZip®) preporutuje se cuvanje dokumenata u kompresovanom obliku — zapakovane u arhive.

Word & Excel - Kurs za poslovne sekretare 7
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MoGUCI PROBLEMI PRI S NIMANJU | OTVARANJU

Ne dovodite sebe u situaciju da dokument uvate na disketu’, veé to uvek radite na hard disku. Disketa je spor i ne-
siguran medijum, pa se (pri ucestalom pristupu) na njoj mogu lako izazvati gre$ke. Sa diskete otvoren dokument ne
menjajte, veé ga otvarajte samo u cilju pregleda ili $tampanja®.

MS Word ima moguénost automatskog ¢uvanja, tekuéeg dokumenta, pa ako ga niste snimali u zadanom vremen-
skom periodu MS Word ¢e to uraditi za vas (ovi fajlovi nose imena kao npr: ~$rd_KPS, gde je zavrSetak imena iden-
tican originalu, a prva dva znaka "~$"). U slu¢aju nasilnog prekida rada u MS Word-u ili ¢ak OS-u (prekid napajanja
ili gre§ka u radu ra¢unara) ovo moze biti od velike koristi. Ovako sac¢uvan dokument je neophodno otvoriti i sacu-
vati pod drugim parametrima, jer ¢e MS Word pri pokusaju otvaranja dati poruku kao na slici. U ovoj situaciji je pot-
rebno potvrditi na OK| a zatim otvorenom dokumentu dati drugo ime. Kada se uverite da je nova kopija dokumenta
kvalitetna (potpuna), prethodnu verziju moZete obrisati (Delete), naravno preko Windows Explorer-a.

Izlazedi u susret korisniku MS Word izvrSene akcije dobro ¢uva, pa mu tako omoguéava vra¢anje velikog broja obav-
ljenih akcija ¢ak i posle izvrsenog snimanja dokumenta. Ovo moZe izazvati probleme, jer se na istoj lokaciji (folder
na kome je i tekuéi dokument) kreira gomila *.tmp fajlova sa imenima kao npr.: WRL3689.tmp WRL3690.tmp i sli-
¢no.

Ako dode do nasilnog prekida rada u MS Word-u ove datoteke (posle zavrSene procedure iz prethodnog opisa) treba
obrisati sa diska. Iako pri pokuSaju otvaranja ovih fajlova, MS Word daje poruku (kao na slici), ipak ne moZe da obe-
zbedi pristup njenom aZuriranju, ali ako iz Tak Managera (aktivirajte ga pre¢icom <Ctrl>+ <Alt>+ <Del>) zavr-
Site Winword koji i dalje radi sam, mociéete ove fajlove da otvorite, pa iz njih iskoristite delove dokumenta koje ste
vel obradili (prebacite ih kopiranjem).

Osnovne tehnike unosa i azuriranja teksta

PRAVILA UNOSA TEKSTA

Najcesce greske pri unosu teksta su vezane za znake interpunkcije: tacke, zapete (ili zareze?), upitnici, uzvi¢nici,
zagrade, navodnici,...

Unosedi tekst desava se da korisnik poku$ava da pri tom utice i na izgled teksta (obi¢no samo privremeno), ali cesto
koristi pogre§ne metode.

Neke efekte je bolje postiéi formatizovanjem, a ne aZu-
riranjem, pa usvojite i sledeéa pravila:

e NIKADA DVA ZNAKA RAZMAKA (dva puta za-

Navesc¢emo nekoliko osnovnih pravila:

e Znak interpunkcije se "lepi" za prethodnu, a ne sle-
deéu re¢. Dakle pre zapete, tacke, upitnika i sl., ne

stavlja se blanko, ali iza svakog od tih znakova
blanko treba uneti. Ispravno je, dakle, ovako, a ne
ovako ,ili ovako .

Kada su u pitanju zagrade i znaci navoda, blanko se
stavlja sa spoljne strane, odnosno ispred otvorene i
iza zatvorene zagrade, dakle (ovako) a NE

nesto kao(

redom <Space> taster), jer ovo dovodi do nerav-
nomernog rasporeda redi u istoj liniji (redu);
NIKADA DVA PRAZNA REDA? (dva puta zare-
dom <Enter> taster), ovo dovodi do oteZanog for-
matizovanja pasusa, jer se pri tom deSavaju
promene u odnosu izmedu njih, pa se esto zahteva
i aZuriranje u cilju brzog i lakog preformatizovanja

ovako), celog dokumenta.
(ovako) NIKADA REC NE DELITE NA SLOVA"® ukuca-
, ili (ovako). vajudi blanko izmedu njih, jer ovo dovodi do ignori-

Po blanko izmedu svake dve reéi i ruzna i neuravna-
ta desna ivica su tek PREDUSLOVI za "normalan"
prelom teksta.

Lepo je $to koristite sve moguénosti MS Word-a, ali
on moZe vise od ukra§avanja ubacivanjem gomile
nepotrebnih i ¢esto neukusnih simbola. Na taj na-
&in ste sve dalje od dobrog teksta, a sve bliZe kicu.

sanja informacije (re¢ predstavlja potencijalnu
informaciju, ali pocepana na pojedina¢na slova NE)

napomene

7 . ) . . y y . . .
Ovde éemo izuzeti situaciju kda treba da uve?bate sam proce§uvanjai to na manjim dokumentima.

& Word dokument izWindous Explorer moZete od$tampati i ne otvarajudS Word , veé prekoPopUp menija i stavkePrint, gde ¢e Windous
Explorer sam otvoriti dokument, paslediti gaMS Word -u, a on na podrazumevani Stampa

9 ) . . . . . s
Prazan prostor izmelu pasusa se moZe postiéi formatizovanjem pasusa prelformat »Paragraph (Spacing : Before ili After).

1% Razmak izmelu slova u rei se moe postiéi prekdormat »Font (Spacing : Expanded npr. preko 2 pt.)

8
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KODNI RASPOREDI TASTATURE

Dobro je poznato da kod nas postoji ¢itava paleta kodnih rasporeda za YU slova, koji se vise ili manje koriste u raz-
nim okruZenjima za tekst procesiranje i stono izdavastvo. Veéina profesionalnih korisnika MS Word-a (i ostalih Mic-
rosoft Office programa) koristi kodnu stranu 1250"" (srpska latini¢na). Ovo ne treba da vas obavezuje - tekst moZete
pisati u bilo kom rasporedu, sve dok YUCC'? moZe da obavi potrebnu konverziju. Ako obradujete neki tekst opste
prirode u kome simboli: [ ] { } |\~ i ~ (koji se kod YUSCII rasporeda koriste za YU slova) nisu potrebni, YUSCII
raspored je prihvatljiv. Medutim, ako je to neki tekst, gde su i ovi simboli potrebni, YUSCII je neprihvatljiv (§to ne
znadi i nemogud). Konverziju biste morali u tom slu¢aju sprovoditi kroz selekcije u dokumentu.

Za vreme ovog kursa savetuje se da koristite onaj kodni raspored na koji ste navikli, ali pokusajte da u vasim daljim

radovima ZABORAVITE YUSCII i predete na CP1250, odnosno UniCode ili CE fontove.

Koristite ga veé godinama? Zao mi je, ali vreme je da prestanete.
(preuzeto iz Casopisa "PC Press" uputstvo za sara  dnike)

Copry, CuT & PASTE

Za komforno aZuriranje (ispravke i dopune) dokumenta ovo su samo osnovne metode. Davno je pro§lo vreme (a kao
da je juce bilo) kada smo ih smatrali naprednim metodama.

Ove akcije su primenjive i u cilju preuzimanja teksta (ali i grafike, tabela,...) iz drugih programa i servisa u Windows
okruzenju, kao npr: iz svih programa Microsoft Office paketa, iz sistemskog Help-a, Web Browser-a i drugih Internet
servisa, iz Adobe AcrobatReader-a, teksta i/ili grafike iz grafi¢kih programa (Photoshop, CorelDRAW, i sl.).

Znacenja ovih akcija su: Nacini na koje moZete koristiti ove akcije su:
Copy™ kopiranje (memorisanje), ne mozete gaoba- o iz menija Edit, $to svakako treba izbegavati zbog
viti ako prethodno niste selektovali neki deo inertnosti samog sistema padaju¢ih menija;
teksta (dokumenta); e preko palete Standard, gde su smestena tri koman-
Cut isecanje (brisanje sa memorisanjem obrisa- dna dugmeta sa asocijacijama na ove akcije;
nog), gde opet morate imati selekcijunakoju e preko tasterskih precica: <Ctrl>+C (za Copy),
se akcija odnosi; <Ctl>+X (za Cut) i <Ctrl>+V (za Paste);
Paste lepljenje (memorisanog), i aktivna je ako je e preko PopUp™ menija koji se dobija desnim klikom
nesto prethodno kopirano ili ise¢eno. miSem u neku lokaciju (ili bolje selekciju).

Da nas nabrajanje ne bi odvelo predaleko izve$¢emo zaklju¢ak da se: koriséenjem Clipboard-a, u Word d okument
mogu preuzeti svi objekti ¢ija obrada ima smisla u jednom tekst procesoru

ISPRAVLJANJE | BRISANJE

Pod ovim se najée$c¢e podrazumevaju poslovi u cilju ispravljanja gre$aka, te dodavanje ili uklanjanje teksta. Da biste
ove poslove korektno obavili biée vam dovoljno poznavanje navigacije (kretanja) kroz dokument i osnovnih tehni-
ka aZuriranja (<Delete>, <Backspace>, <Enter>, <Space>). Za ubrzanje aZuriranja i smanjenje moguc¢nosti po-
jave greSaka u vaSem tekstu trebalo bi da koristite napredne tehnike aZuriranja (bi¢e obradene u nastavku).

UNDO, REDO

Davno je proslo vreme kada smo u programima dobili moguénost da poni§timo poslednju izvrsenu akciju (Undo), ali
kada je MS Word ponudi visestepeni Undo - svi su redom poZeleli istoi u Zivotu, jer jedna greska nikada ne ide sama.

Pa tako, ako uradite nesto §to niste "mislili ozbiljno" moZete kliknuti na komandno dugme u Standard paleti sa iko-
nicom u vidu zakrivljene strelice ulevo - Undo, ¢ime se vracate na stanje pre poslednje izviiene akcije (neki bi rekli:
"jedan korak unazad"). Samo akcije, kojima se uti¢e na tekst ili dokument (formatizovanje i aZuriranje) se mogu po-
nistiti, ali ne i one akcije koje se odnose na pregled i navigaciju kroz dokument.

napomene
" Kodne rasporede (tastature) i potrebna podesavanja OBindows -a se obratuju na Gsnovnom kursu.
2yucc je mali makro dodatak zaVS Word i MS Excel ¢&iji zadatak je konverzija vaseg dokumenta (ili njegovog dela) iz jednog (od 13 asp
lo%ivih) u drugi kodnihrasporeda, kao i éirilicu.
13 Kopiranje— Copy ne treba poistoveéivati sa dupliciranjem.
Kopiranje predstavlja tek snimanje u cilju zavr$etka dupliciranja lepljenjerfuste .

14 “ ST . . e . - g .
U nagoj informatékoj literaturi se zaPopUp meni ravnopravno koriste izrazi korekstni meni i plutajuéi meni, isl.
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A ako se pokajete zato §to ste se pokajali'®, kliknite u komandno dugme sa ikonicom u vidu sli¢ne strelice udesno,
koje predstavlja Redo, tj. poniStenje poslednje Undo akcije.

Ali, ako poZelite da se vratite za nekoliko koraka unazad (Undo), a posle toga mozda i unapred (Redo), trebalo bi da
pored komandnog dugmeta (s desne strane) uocite strelicu nadole. Otvaranjem na ovu strelicu dobijate listu svih
akcija ¢iji je Undo mogué (slika levo), odnosno svih akcija &iji je Redo mogué (slika desno).

Bez ikakve opasnosti, koriste¢i nekoliko puta Undo, a zatim — Redo, moZete pregledati koje ste sve akcije obavili u
obradi tekuceg dokumenta, ali vodite ratuna da ne moZete otiéi u situaciju (status, stanje) od pre, uvesti neku pro-
menu i bezbolno se vratiti u "sadasnje vreme", jer: OBAVLJENE AKCIJE NE MOGU DA SE PRESKACU, isto kao
$to u Zivotu, naZalost, ne moZete da se vratite kroz vreme u pro$lost da biste uticali na budué¢nost.

Prema ovom svojstvu MS Word-a moZete i sami zakljuciti da on samo pokuSava da simulira prirodne procese i tako
se svojim kvalitetom, kao i mnogi napredni programi Windows okruZenja, uvlaci korisnicima pod kozu i $to ga vise
budete izucavali i upoznavali to ¢e vas njegova jednostavnost i efikasnost, svakim novim saznanjem, o¢arati.
Zajedno sa Undo i Redo akcijama treba koristiti i akciju Repeat, koja ¢e biti obradena u slede¢im lekcijama.

napomene

" Signirani tekst je ispravan i pored toga §to vam se (na prvi pogleddimilo da nesto nije uredu- Redo vam nudi ponistenjdndo akcije, pa u
tom smislu predstavlja pokajanje pokajanja.

10 MS Word - Osnovne tehnike unosa i aguriranja teksta



R S. Mikanovié

2] MS Word

Formatiranje karaktera

NA STA SE ODNOSI

U formatiranje karaktera spadaju ona formatiranja kojima se uti¢e samo na izgled znakova i simbola i ne odraZava se
na izgled pasusa. Dijalog Font'® (preko Format»Font) je centralno mesto formatizovanja karaktera (slova) i omogu-
¢ava detaljno podesavanje njihovog formata kroz tri kartice: Font, Character Spacing i Animation. U dnu dijaloga
(okvir Preview) dobicete primer teksta koji ste selektovali i nad kojim obavljate formatizovanje, ali ako dijalog otvo-
rite bez trenutne selekcije u Preview ¢ete dobiti samo ime fonta (pa se u tom slu¢aju formatizovanje karaktera odnosi
samo na tekst koji ¢ete unositi od tekuée pozicije nadalje).

FONT

Font je skup znakova i simbola definisanog i uskladenog izgleda npr. TimesNewRoman, Arial, Tahoma,... Prime-
nom razli¢itih fontova se moZe posti¢i lep izgled teksta, ali treba imati u vidu da se preteranom upotrebom stilova
fonta (B, I, U) i velikog broja fontova u istom dokumentu moze dobiti Saren i tesko &itljiv tekst. Word na ovom polju
pruza velike moguénosti, pa je teZi zadatak odluditi se na manji broj efekata iz velikog skupa ponudenog. Font koji
odaberete iz liste Font je onaj koji ¢e biti primenjen na selektovani tekst.

Najbrzi izbor Font-a se moZe ostvariti iz grafickog ComboBox-a u Formatting paleti (kao na slici), gde su dati nazivi
fontova i/ili primer teksta. Font moZe biti i set znakova, pa se nemojte iznenaditi ako izborom nekog fonta pretvorite
formatizovani tekst u "zoologki vrt."

Drugi nacin formatizovanja karaktera je iz dijaloga Font, do kojeg se dolazi preko Format»Font. Dijalog sadr#i tri kar-
tice: Font, Character Spacing i Text Effects (kao na slede¢im slikama)

U listi Font se bira naziv fonta, a u listi Font style se moZe primeniti:
Regular bez posebnog stila fonta;
Bold podebljan tekst (masan);
Italic zakosen (kurziv) tekst;
Boldltalic podebljan i zakosen tekst;

U listi Size se bira veli¢ina slova u opsegu od 1 do 1638 pt. Ovaj tekst je u svom najvec¢em delu ureden u fontu
GoudyOISt BT u veli¢ini 10 pt, dok je za naslove koriséen font Humanst521 BT u veli¢ini 12 do 16 pt.

Podvuéen tekst moZe da se defini$e preko ComboBox-a Underline (preko tastature na <Ctrl>+U), gde se moZe oda-
brati nekoliko vrsta linija kojima se vi$i podvlacenje, dok se boja teksta moZe odabrati preko ComboBox-a Color.

napomene

16, .. .. . . . . e . o
Veéina parametara koji se ovelzadaju, moguée je zadati i prekdoolbar -a Formatting i preko tastature, pa éete ih sigurno ubuduée koristiti,
jer ée vam dijalogFont sigurno adnositi mnogo vremena.

Word & Excel - Kurs za poslovne sekretare 11
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EFFECTS

Da biste sagledali primenu efekata preporucuje se da veli¢inu postavite na vrednost preko 20, pa birajte naizmenic-

no jedan po jedan efekat:

NAZIV | OPIS PRIMER
Striketrough | precrtavanje
Double | dvostruko precrtavanje
striketrough
Superscript | tekst u stepenu xly? Primer telesta sa efekrom
Subsrcipt | tekst uindeksu X2V3 Primer teksta sa efektom
Shadow | tekst sa senkom (koji se u §tampanom obliku dobija sa- Primer teksta sa efektom
mo kod §tampaca sa preko 300 TPI)
Outline | za prikaz samo grani¢nih linija slova (bez popunjavanja) Primer teksta sa efeletom
Emboss | za 3D efekat ispup&enog teksta Primer teksta sa efekrom
Engrave | za 3D efekat udubljenog teksta Primer telsta sa efelktom
Small caps | umanjena velika slova, gde se velika i mala razlikuju PRIMER TEKSTA SA EFEK TOM
All caps | sav tekst velikim slovima bez razlike velika/mala PRIMER TEKSTA SA EFEKTOM
Hidden | tekst sa moguénoséu prikrivanja (obi¢no u Stampanom obliku)

CHARACTER SPACING

Ova kartica dijaloga Format nudi moguénosti:

Scale | skaliranje (razvlacenje/ sabijanje) teksta uklju- ) o

Cujudi i blanko karaktere, gde su vrednosti: tekst skaliran na 150%
100% — bez skaliranja, primer teksta skaliranog na 80%
ispod 100% — sabijanje, NE PREPORUCUJE SE ZA SVE FONTOVE
preko 100% — razvladenje.

Spacing | razmak izmedu karaktera: primer za Expanded By 2pt
Expanded — povecavanje razmaka, .
Condensed — smanjenje, za unetu vrednost By primerza Condesed By 1 pt

12
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Position | vertikalna pozicija u odnosu na ostatak teksta: | o1 (ol stq primer za Raised By 2 pt
Raised — uzdizanje teksta, ek
Lowered — spustanje, za unetu vrednost By ostatak teksta primer za Lowered By 2 pt

Kerning | dodatni prostor koji se, van "logike" fonta, dodaje izmedu pojedinih parova slova kako bi re¢ iz-
for fonts | gledala $to prirodnije, a "lepljenje" nekih parova slova izbeglo.

ANIMATION

U Animation kartici dijaloga Font — MS Word vam daje nekoliko predloga najjednostavnijih animiranja teksta, koji
se u Stampanom obliku dokumenta neée videti. Verovatno éete ove efekte koristiti u cilju skretanja paZnje na
odredene segmente, posebno kada dokument $aljete vadim kolegama ili prezentirate dokument preko ekrana.

PODRAZUMEVANI FORMAT KARAKTERA

Podrazumevani format karaktera vas uvek ¢eka kada kreirate novi dokument. Ako ovo ne podesite, moracete pri
svakom novom dokumentu selektovati sve i zadati Zeljeni format karaktera.

Da biste u Word-u podesili kao podrazumevani font onaj koji vam odgovara i najc¢esée koristite, potrebno je da otvo-
rite dijalog Format i u njemu podesite sledece:

1. ulisti Font izaberite jednostavan (ne suvi$e kitnjast) font
savetuje se da to bude neki od UniCode fontova koji imaju ugradena srpska latini¢na i ¢irili¢na
slova, a koriste se promenom tekuéeg kodnog rasporeda tastature;

Style postavite obavezno na Regular;

Size izaberite izmedu 101 12;

Underline postavite na (none);

Color na Auto (Black);

sve efekte u grupi Effects, kao i u preostale dve kartice ovog

dijaloga OBAVEZNO ISKLJUCITE;

pa kada se (pregledom datog primera u Preview) uverite se da je tekst Citljiv i jednostavan — kliknite na taster
Default... u donjem levom uglu dijaloga. Posle ovoga dobicete poruku sa upozorenjem da e se izvisiti promene u
generalnom $ablonu, pa ako Zelite ove promene — odgovorite sa Yes., u suprotnom No.

A

SPECIJALNI SIMBOLI

Kada je u tekst potrebno ubaciti neki specijalan znak'” (simbol) potrebno je, preko Insert» Symbol, aktivirati dijalog
Symbol: (kao na prvoj slici), gde treba izabrati simbol i dvostrukim klikom na simbol (ili klikom na komandno dugme
Insert), ubaciti simbol u tekst. Za ubacivanje simbola na jo§ neko mesto u dokumentu, treba (bez zatvaranja ovog di-
jaloga) locirati kursor na Zeljenu pozicijui u dijalogu odabrati simbol. Dijalog se moZe zatvoriti na dugme Close ili ta-
ster <Esc>.

Ako Zelite da za neki simbol definigete tastersku precicu potrebno je otvoriti Customize Keyboard, pa u njemu je do-
dati. U kartici Special Characters moZzete pregledati uvedene tasterske precice i dodati nove.

@
W==_

Tekst se smatra dobro (3to ne znaci obavezno i lepo) formatizovanim ako ste u njemu ko-
ristili NAJVISE 2-3 fonta, a postigli svu lepotui bez primene specijalnih efekata. Da biste
se sami uverili u valjanost vaSeg teksta bacite oko na neku knjigu uradenu pre 10-ak godi-
na. Moguénost MS Word-a ne bi trebalo da vas zanese, pa da od teksta pravite strip.

Word, kazu mnogi, ne podrfava kerning, §to mu je veliki nedostatak u poredenju sa ostalim
DTP programima. PaZljivije prelistavanje dokumentacije pokazace da je ova tvrdnja Cista
zabluda — MS Word podrZava kerning, ali samo ako ga ukljucite. Podimo redom. Prethodno
je re¢eno da kerning "dodaje" prostor izmedu parova karaktera, ali dodavanje moZe biti i
negativno: par slova AV u mnogim fontovima izgleda znatno bolje ako se umanji prostor
izmedu njih. Informacije o kerning parovima postoje kako u TTF tako i u PostScript i svim
drugim Windows fontovima; na tekst procesoru je samo da ih iskoristi.

napomene

17 . o . o - . ot
Ne preterujte sa ubacivanjem simbola, jer time dokument moZe izgubiti na lepditikosti i stilu.
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PRIMENA AUTOMATSKOG F ORMATIRANJA PRI AZUR IRANJU ®

Kod primene tasterskih precica za formatiranje karaktera nije obavezno selektovati tekst u slu¢aju kada formatiranje
treba primeniti samo na tekuéu re¢ (kao npr. Bold, Italic, Underline, uveéanje, umanjenjs. . .)

<Cul>+B -Bold tekst

<Ctl>+1 - Italic tekst,

<Ctl>+U - Underline tekst

<Ctl>+> —uveéanje velitine fonta i

<Ctl>+< — umanjenjeveli¢ine fonta
¢ime se postize veliko ubrzanja poslova oko formatiranja teksta — jer se obavlja u toku aZuriranja.
Dok vrsite unos teksta pokusajte da $to vise iskoristite tastaturu i precice preko nje, jer mi§ pri ovom moZe odvuéi
paZnju i zadr¥avati vas.

Pored tasterskih precica, za formatizovanje karaktera mogu se koristiti i sledeéi automatizmi:

TEKST UNET KAO | FORMATIZOVACE SE KAO

*Internet* | Internet

_marketing_ | marketing
"Duca & Co." | “Duca & Co.”
(Lst) | (1%
172 | %

www.interbest.co.yu | www.interbest.co.yu

INFORMACIJE O FORMATU @

Kada dodete u situaciju da kreirate obimniji dokument, pa poZelite da brzo sagledate gde ste kakvo formatizovanje
zadali moZete iskoristiti tzv. info oblaci¢, koji pokreéete na <Shift>+F1. Kada se pointer miSa pretvori u strelicu sa
znakom upitnika — kliknite u tekst &iji format vas zanima, pa ¢ete dobiti mali "oblak" u kome ¢ée biti opisani osnovni
parametri formata tekuceg teksta, grupisani u format paragrafa i format karaktera (kao na slici).

napomene

18 . . g . . P . L .
Ovim se akcijama ne zadaje fiksna valina fonta za selekciju, ve¢ se svakom karakteru povec¢ava, odnosno umanjuje &ieli1 za 1pt bez obi-
ra na druge karaktere.

14 MS Word - Formatiranje karaktera
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Formatiranje pasusa

VAZNOST FORMATA PASUS A

Kao to se, do sada rade¢i u MS Word-u, primetili — pasus se ne prelama dok vi to ne odlugite'?, dok je prelazak tek-
sta u novi red (istog pasusa) automatizam koji poznaju svi procesori teksta. ZavrSetak jednog pasusa se prepoznaje
po znaku 1 — paragrafu®® i to pod uslovom da ste ukljucili vidljivost "neprintabilnih" karaktera preko komandnog
dugmeta sa ikonicom u vidu istog simbola i tekstom Show/Hide ¥ ili preko tastature <Ctrl>+(. Svaki novi pasus se
kreira pritiskom na <Enter> i nasleduje parametre formatizovanja od svog prethodnika, a moZe mu se zadati i neki
drugi format preko Format» Paragaph.

Pri zadavanju izmena u formatu jednog pasusa nije ga potrebno selektovati veé je dovoljno pozicionirati kursor u
njega, ali kada treba formatizovati viSe pasusa — neophodno ih je obuhvatiti selektovanjem. Na pasus ¢e biti prime-
njen format ¢ak i kada je on nepotpuno selektovan.

Dakle — formatizovanje karaktera i formatizovanje pasusa se razlikuje u mnogome i nemoijte ga poistoveéivati?'. Nis-
ta u tolikoj meri ne uti¢e na globalni prelom dokumenta kao — formatizovanje paragrafa, jer se preko njega moZe uti-
cati na poravnanje teksta, razmak izmedu pasusa, razmak izmedu redova u pasusu, vezanost redova i pasusa,
automatski prelom strane,...

NACINI PRISTUPA FORMA TU PASUSA

Formatu pasusa moZete pristupiti na sledeée nacine:

¢ iz meni linije — Format» Paragraph (¢ime se dobija dijalog)

e preko horizontalnog lenjira (samo za neke parametre)

o preko komandnih dugmadi u paleti Formatting (samo za neke parametre)
preko PopUp menija u stavku Paragraph (sledi dijalog).

Za pocetak ¢emo otvoriti dijalog Paragraph i u njemu isprobati:

napomene

19 . . (@1 p o . o
Osnove rada u procesorima teksta ste radili i na Osnovnom kursu, pa ovde neémo ponavljati pravila korid¢enja tastera <BackSpace>,
<Delete> i <Enter> u povezianju prelomu pasusa.

20 - ) o . . . . -
Da bi izbegli sukob u izraZavanju, u nastavku ée se paragrafom nazivati samo simboPfagraph Mark ), dok se pod formatom paragrafa misli
na formatpasusa.

21, . . . e e « . :
Veéina korisnikaMS Word -a, kada se pomene formatizovanje misli isklfivo na format karaktera. Zasto? Pa verovatno zato $to formatiz
vanje pasusa i ne koriste (verovatno im nije zatrebalo).
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u kartici Indents and Spacing:

NAZIV | ZNACENJE OPIS
Alignment | nacin poravnanja Left levo (<Ctrl>+L)
(uravnanja Centered centralno (<Ctrl>+E)
pasusa) Right desno (<Ctl>+R)
Justified obostrano (<Ctrl>+])
Indentation | pomeranje pasusa Left uvlacenje pasusa od leve margine
(margine | od margina strane Right uvlacenje pasusa od desne margine
basusa,)

Special | odnos prvog reda | First Line  uvlacenje prvog reda u pasusu za vrednost u By

pasusa prema Hanging  uvlalenje ostalih redova (osim prvog) za vrednost
ostatku pasusa u polju By
Spacing | razmak izmedu Before  prazan prostor ispred odnosnog pasusa
pasusa After  prazan prostor iza odnosnog pasusa
Line Spacing | prored izmedu Single  uobitajen (za veli¢inu znakova - fonta)
redova pasusa 1.5 lines  uvecan za 50% od veli¢ine fonta

Double  dvostruki (kao pun prazan red)

At Least najmanji moguéi prored za vidljivost svih znakova
po visini (slu¢aj razlicitih visina znakova) koji
Word automatski pode§ava prema njima
Exactly  prored koji Word ne sme automatski menjati
Multiple sve ostale moguénosti smanjenja (od 0,06 do 1) i
povecanja (od 1 do 132 linije).

Ako ne Zelite da se redovi u okviru vaseg Word dokumenta automatski razmicu (vertikal-
no) u zavisnosti od visine slova i interpunkcije, aktivirajte Format» Paragraph» Indents»
Spacing a onda izaberite Exactly. Ma kakve subscript-e i superscipt-e ubuduce umetali, re-
dovi ¢e biti jednako razmaknuti, ¢ak i ako se slova ispiSu jedna preko drugih. Kod izbora
At Least proreda u pasusu moZe se desiti da u jednom istom pasusu imate razli¢ite prorede.

e—

U kartici Line and Page Breaks su na raspolaganju parametri:
NAZIV | OPIS

Widow/Orphan | spre¢ava pojavu tzv. udovice i siro¢iéa:

control | Widow, predstavlja situaciju kada je jedan red pasusa na jednoj, a svi ostali na
sledecoj strani,
Orphan, kada su svi na jednoj, a samo poslednji na pocetku sledeée strane.

Keep lines | zadrzava sve linije (redove) jednog pasusa zajedno na istoj strani ili u bloku
together | (blokovi za tekst se javljaju u situacija kada se sa tekstom kombinuju i graficki

objekti)

Keep with next | zadrZava (spaja) pasus uz sledeci
(uobicajen slu¢aj kod naslova svih nivoa)

Page break | nevidljivi i najfleksibilniji prekid strane ispred pasusa
before | (uobicajeno za naslove prvog nivoa)

Suppres line | sprecava da se u tekuéem pasusu prikazuju brojevi linija, §to nema efekta u do-
numbers | kumentu ili sekcijama gde nije definisan prikaz broja linija (moZe biti definisan
preko Page Setup»Layout» Line numbers ...
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Don't hyphenate | za spreCavanje preloma na slogove u pasusu
(ako je prelom prethodno postavljen kao automatski na nivou dokumenta)

Mnogo toga moZete obaviti i preko Toolbar-a Formatting i horizontalnog lenjira:

TABULATORI

Akcija koja se obavlja tasterom <Tab> zavisi od programa (i njegovog servisa), a kod azuriranja teksta u DTP??
programa se koristi za prelazak u sledeé¢u definisanu kolonu za zaustavljanje (T stop position). Format tabulatora va-
%1 za tekudi pasus i prenosi se na isti nacin, kao i format paragrafa, u novi pasus (pri unosu teksta). U istom redu mo-
Ye biti zadano vise Tab stop pozicija i vaZe na isti nadin u svim redovima pasusa u kome su zadani. Pritiskom na taster
<Tab> zaustavljate se na prvom definisanom T stop-u, drugi unet <Tab> zaustavice se na drugoj poziciji, itd.,
gde je i nadin njegovog zaustavljanja vaZan i moZe se podesavati, kao i obeleZiti trag (preskoceni prostor). Tab stop
pozicije se mogu definisati preko horizontalnog lenjira ili preko dijaloga Tabs.

Preko lenjira se Tab stop pozicije defini§u kada je samo potrebno odabrati jedan od 5 tipova i njegovu poziciju, pa se
koristi na sledeéi nacin:

1. pozicionirali ste kursor pasus gde Zelite definisanje;

2. ulevom uglu horizontalnog lenjira (klikom na kvadrati¢) odaberete tip

Pored uobicajenog kori§¢enja u pasusu Teb stop je vrlo zgodan za kreiranje sledeéih oblika teksta:

Left Tab ‘ Center Tab ‘ Right Tab
................ tekst je u ovom slucaju za- ovaj tekst je tabuliran cevrerenseennenepIiMET teksta
poetprvona 1,5¢cm,  pa zatim centralno | ... pomerenog udesno
na4cm od8-ogcm | e, sa <Tab>
........................... na 14 cm
(svakim slede¢im klikom dobija se slededi tip);

3. kliknite (bez povlacenja) na lenjiru, gde biste Zelite Tab stop;
Decimal Tab Bar A

15.103.334,78 — pravilno, sa decimalnim zarezom desni Tab | levi Tab

tekst 1,013232 —pravilno, sa tekstom ispred obradio: | Dule & Co
1.656.54.125,6 din —pravilno, sa tekstom iza nadzirao: | Andreja sa saradnicima

21 tekst 45,78 — nepravilno, kombinacija teksta i cifara sa ubalenim Bar tabulatorom izmedu
34.654 —nepravilno, pogresan decimalni simbol
4.3231,345.87 —nepravilno, pogresan separator grupa cifara

Decimal Tab je izuzetno osetljiv, pa pokusajte da ispoStujete data pravila. Pre svega pogle-

Kada je tabulatore potrebno detaljno podesiti potreban je Tabs dijalog, koji se moZe pozvati na jedan od nagina:
e Format» Tabs... i
o iz dijaloga Paragraph
(komandno dugme Tabs. .. u donjem levom uglu prozora)

dajte da i ste u Regional Settings® Control Panel-a vaseg Windows-a podesili decimalni
simbol i separator grupa na valjane vrednosti (zapeta odnosno tacka za nas region).

<Tab> taster se u dijalog box-u koristi za kretanje kroz stavke u jednom, dok se za kretanje u suprotnom smeru kori-
sti <Shift> + <Tab>.

napomene

ZpTp (Desktop Publishing ) — programi namenjeni stononizdavastvu.
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[3] MS Word

Tehnike azuriranja sa izmenom formata

AUTOMATSKA NABRAJANJA

MS Word poznaje dva tipa nabrajanja i to: znakovno — Bullets i brojevno Numbering, izmedu kojih je jedina razlika to
§to je kod nabrajanja Bullets — isti znak ispred svih stavki, a kod Numbering (brojevi ili slova) lista se progresivno na-

stavlja. Za tekuéi pasus nabrajanje se moze ukljuciti (ili iskljuciti) preko odgovaraju¢eg komandnog dugmeta iz For-
matting palete (kao na slici)

Bolji na¢in da se "isprovocira" nabrajanje je primenom AutoFormata, kojim Word u ovom slu¢aju automatski postav-
lja nabrajanje u zavisnosti od pocetnih znakova u redu koji ste ukucali (i pritisnuli <Enter>). Dovoljno je da novi
red zapo&nete nekim od znakova: -, ¥, #, > ili brojem sa tatkom ili zagradom, kao npr.

UKUCANO | FORMATIZOVANO UKUCANO | FORMATIZOVANO
- da li uocavate - dali uocavate DA 1. nabrajanje | 1. nabrajanje
- obavezno morate ukucati 2. numerisanjem
* blanko iza simbo- | ® blanko iza simbola, 1) mora poceti | 1) mora po&eti
la, e astavku zavrsiti sa <Enter> 2) prvim brojem
> kada Zelite DA > kada Zelite DA (A) ili slovom, | (A)ili slovom,
» zavrSite nabrajanje (B) pa ¢e se nastaviti
progresivno
a) HaXaJloCT | a) He MOoKe NUPHITMYHO

Ako pozelite detaljno zadavanje oblika nabrajanja potrebno je da otvorite Format» Bullest and Numbering, pa u dija-
logu mozete:

o odabrati neki oblik nabrajanja: simbolima, brojevima i slovima ili op$tu listu (npr. za numerisanje naslova);
e restartovati nabrajanje (da zapo¢ne prvim brojem ili slovom) preko Restart numbering;
e izmeniti oblik tekuéeg nabrajanja preko Customize, gde dobijate dijalog kao na slici desno:

Kod oblika nabrajanja Bullet, omoguéeno je (preko dijaloga kao na slici) postavljanje i slike umesto simbola.
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AUTOCORRECT

Prvobitni cilj ovog servisa je bio da korisniku ispravlja greske pri unosu teksta, ali je vremenom dobio i primenu u si-
tuacijama kada je ¢esto potrebno otkucati neku komplikovanu re¢ (sloZenicu) ili nekoliko redi.

U njemu su veé unete neke odrednice za korekciju uocenih sistematskih gre3aka pri unosu teksta na engleskom, a vi
ih moZete brisati i unositi neke nove. Ne zaboravite da obriSete odrednicu i » I, jer u engleskom jeziku ne postoji

" korigovati u veliko "I".

samostalno slovo "i", pa ée vam svaki veznik "i"

Da bi se AutoCorrect koristio potrebno je u njega najpre ubaciti potrebnu odrednicu i to u obliku:
kratka rec¢ koju kucam » sloZenica koja mi treba.

AutoCorrect koriguje uneti tekst posle otkucanog nekog znaka interpunkcije, broja, specijalnog znaka ili praznog
prostora (blanko), a ako je zadan formatizovani tekst — primeniée se i format kakav je odreden prilikom kreiranja od-
rednice. Najbolji na¢in za uvodenje odrednice je slededi:
1. otkucajte sloZenu re¢ ili izraz, pa ga selektujte
(ne ukljutujte u selekciju paragraf — oznaku kraja pasusa, ako ne Zelite da Word pri korigovanju
prelazi u novi red);
2. otvorite dijalog na Tools» AutoCorrect (kao na sledecoj slici);
3. selektovani izraz e veé biti u polju With, pa je jo§ potrebno da u polje Repla-
ce unesete kratku rec
(imajte na umu da ova re¢ ne sme da postoji u nadem jeziku, jer ¢ete u proti-
vnom imati viSe problema nego koristi);
4. ako Zelite da tekst bude korigovan i u skladu sa formatom u selekciji — uklju-
&ite opciju Formatted text;

5. potvrdite na komandno dugme Add i zatvorite na OK.

Kada pozelite da ukinete koris¢enje AutoCorrect-a dovoljno je da u istom dijalogu iskljucite stavku Replace text as
you type, a moZete se isprobati (savetuje se ukljucivanje) i ostale opcije, i to:
Correct TWo INitial CApitals — korigovanje reci koja ukucana sa dva velika pocetna slova u re¢ sa jednim poce-
tnim slovom,;
Capitalize first letter of sentences — korigovanje u veliko slovo prvog slova u zapocetoj reenici (ako Zelite korisée-
nje ovog korigovanja zaboravite na ta¢ku na kraju godine kao npr 01.01.2000.
Jer ¢ete dobiti ovo.
Capitalize names of days — ispravka po¢etnog slova u veliko kada se ukuca ime dana u nedelji
(sa instaliranim dodatkom za srpski jezik, primenljivo je i na$a pisma, kako za la-
tinicu, tako i za éirilicu);
Correct accidental usage of cAPS LOCK key — ispravlja greske kod slu¢ajnog pritiska na <Caps Lock>, ali prvo slovo
ispravlja u veliko i iskljucuje ovaj taster, kao npr. "pRINT" u "Print".
Kada vam se ne dopadne korekcija koju je AutoCorrect obavio moZete pritisnuti <Ctrl>+Z za Undo, ili iskljuciti
sve ono §to vam se ne dopada od ponudenog u glavnom dijalogu AutoCorrect-a. Pri podesavanju AutoCorrect-a tre-
ba voditi raduna o tome da se odrednice, uvedene na ovom mestu, primenjuju u svim Microsoft Office programima.
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Za sluc¢aj da Zelite napravite izuzetke AutoCorrect-a u nekim specijalnim slu¢ajevima (kao npr da "itd." ne prepozna-
je kao kraj recenice) kliknite na komandno dugme Exceptions... u ovom dijalogu i dobiéete novi dijalog (kao na slici
desno »), gde treba ukucati:

o u kartici First Letter sluajeve za izuzece poveéanja pocetnog slova u recenici, a

e ukartici INitial CAps sludajeve izuzeéa od korekcije dva velika pocetna slovai sl.

Izuzetke moZete dodati je preko komandnog dugmeta Add ili neki od postojeéih obrisati iz liste preko Delete.

Bolja (mada nesto sloZenija) varijanta je da — Word-u prepustite da automatski dopunjava ove liste tako §to:
e najpre overite (uverite se da jeste) Automatically add words to list u pomenutom dijalogu i od tada ée Word sam
dodavati u ovu listu reci;
e vaSe je da, kada vam AutoCorrect iskoriguje re¢, a vi ne Zelite korekciju — pritiskaju¢i (samo) taster
<Backspace> obrisete iskorigovani deo i prekucate ponovo. Posle ovoga, AutoCorrect, ovu rec vise neée
korigovati.

AUTOTEXT

Ovaj servis vam daje moguénost da, pored teksta kao u AutoCorrect-u, arhivirate i bilo koji drugi OLE objekat koji
Word prepoznaje (gotovo sve komponente iz Windows programa) i to na sledeéi na&in:
1. unesite i formatizujte zaglavlje pisma koje naj¢esce koristite (npr. logotip sa adresom vase firme)
ili znak kao na slici »
2. selektujte uneto i pritisnite <Alt>+ <F3>
(ili preko meni linije na Insert» AutoText» New...);
3. kada dobijete dijalog Create AutoText (kao na sledeéoj slici),
unesite naziv vaSeg AutoText-a, npr: "Memorandum" i potvrdite na OK.

Kada, u nekom drugom (ili istom) dokumentu budete poZeleli isti logo ili memorandum neéete morati da ga unosite
"peske" veé je dovoljno da unesete samo njegovo ime i pritisnete <F3>, a u slu¢aju da ste ukljudili Show AutoCom-
plete tip AutoText and dates u glavnom dijalogu AutoCorrect-a, na kartici AutoText, (kao na slici desno), dobiéete pre-
dlog nastavka zapocetog imena AutoText-a koji ste kreirali (imena dana u nedelji ili datum), pa da biste ga ubacili
pritisnite na <F3>. Za pregled i aZuriranje, AutoText moZete otvoriti na isti nacin kao i AutoCorrect, i naéiéete ga u
kartici AutoText.

AUTOFORMAT

Ovaj servis se podesava u kartici AutoFormat dijaloga AutoCorrect i predstavlja samo dopunu druge kartice u istom
dijalogu. Neke su stavke iste, pa je svejedno gde ¢ete ih podesiti, a ono §to je u ovoj kartici dodano je vezano za de-
finisanje gde treba, a gde ne treba primeniti AutoFormat.
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FIND & REPLACE

Find/Replace® servis, kao i u ostalim servisima sluzi za pretraZivanje i ispravljanje prema zadanim parametrima:
Find what §ta traziti (<Ctrl>+F)
Replace with &ime zameniti (<Ctrl>+H)
Go To odlazak na objekat ili poziciju (<Ctrl>+G ili F5)

dok se na komandno dugme More (odnosno Less) dijalog moZe prosiriti (odnosno smanjiti) za dodatne opcije:

Search kroz koji deo dokumenta, gde se moZe izabrati:
Down nadole ili

Up nagore od tekuée pozicije, ali i
All kroz ceo dokument.

Replace grupa komandnih tastera koji omogucuju:

Format zadavanje bilo kakvog od poznatih formatizovanja;

No Formatting uklanjanje zadanog formatizovanja;,
Special izbor nekog specijalnogkaraktera®;

REPEAT (UNDG, Repo) @

Akcije Undo i Redo smo pomenuli kod aZuriranja, ali Repeat akcija je, i pored veze sa ove dve, namenjena samo za
ponavljanje poslednje izviiene akcije bez obzira da li je to bila akcija aZuriranja ili formatizovanja. Veza Repeat i Re-
do je sledeca: ako niste koristili Undo onda umesto Redo vam stoji na raspolaganju Repeat. Ako npr. otkucate <Bac-
kSpace>, pa zadate Repeat — bic¢e obrisan jo§ jedan znak ulevo itd.

Bolja primena akcije Repeat je kod formatizovanja i to:
1. izvrite formatizovanje (preko dijaloga) nad nekim delom teksta;
2. selektujte neki drugi deo teksta i pritisnite <Ctrl>+Y (ili preko manija na Edit» Repeat)

pa Cete uoditi da je prethodno formatizovanje primenjeno i na drugi deo teksta. Uocite da Repeat moZete ponavljati
viSe puta sve dok ne obavite akciju koja vam ne odgovara, odnosno dok ne primenite Undo, (¢ime MS Word na mes-
to akcije Repeat (u meniju) daje na raspolaganju Redo (kao i poziv istom tasterskom pre¢icom <Ctrl>+Y), a na pa-
leti Formatting onemoguéava komandno dugme za Repeat (kao na drugoj slici).

napomene

23 . . . NP e . . . )
MS Word u ovom dijalogu daje i servi€Go To koji sluzZi za odlazak na karakteris¢ne (ili imenovane) objekte kao $to su: strane, slike, tabele i
sl., a sli¢an je Object Browser -u i opisan u temi- navigacija kroz dok ument, pa se ovde neée opiivati.

24 o ) . .
Specijalnim karakterima se smatraju oznake za: kraj pasusa, prelom strane,
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KOPIRANJE FORMATA @

Evo interesantnog alata koji se malo koristi, a moZe biti izuzetno vredan — Format Painter. Ako postoji mesto u va-
Sem dokumentu sa definisanim formatom, koji Zelite da primenite na nekom drugom mestu, uradite sledece:

1. selektujte blok ¢iji format Zelite iskopirati;
2. kliknite na dugme Format Painter (sli¢ica cetke za farba-
nje), pa e se kursor promeniti u ¢etku za farbanje;

3. dodete do mesta na kome Zelite da primenite kopirani
format i miSem prevucite taj deo teksta.

To je sve — Word ¢e automatski primeniti kopirani format. Ako vise volite rad preko tastature (a sigurno ste ve¢ na-
vikli da selektujete bez "prevladenja") tada format sa selektovanog teksta moZete kopirati preko komande Copy For-
mat <Crtrl>+ <Shift>+C, a primeniti ga na drugi tekst komandom Paste Format <Ctrl>+ <Shift>+V, pa éete
primetiti kako je ovo univerzalan i jednostavniji na¢in za veée blokove.

Obrada tabela u MS Word-u

TABELE U MS WORD —U, DA ILI NE

Odgovor bi bio: STO MANJE, jer bi trebalo da svaka tabela u MS Word-dokumentu stane na jednu te istu stranu,
kao i da ne preterujete sa $arenilom u njoj. Tabela je osnovni oblik organizacije podataka, pa prema tome obi¢no slu-
%i za Cuvanje i aZuriranje podataka, ali moZe poslufZiti i za kreiranje specifi¢nih obrazaca. MS Word nudi velike mogu-
¢nosti dizajna, ali i neke osnovne (i nedovoljne) oblike proraduna u tabelama. Kako postoje programi
specijalizovani za obradu tabela i izradu matemati¢kog modela (kao $to je to MS Excel) uvek je bolja varijanta ubaci-
ti tabelu iz takvog programa nego je kreirati u MS Word-u.

KAKO UBACITI | AUTOMATSKI FORMATIZOVATI TABELU

Osnovni nadini ubacivanja nove prazne tabele su:
o Table» Insert Table ili

e preko komandnog dugmeta u Formatting paleti, gde moZete vizuelno odrediti dimenzije vase tabele (mala ta-
bela koju inicijalno dobijate je dimanzija 4x5, ali se razvlacenjem do Zeljenih dimenzija i ona povecava).

Ako tabelu ubacujete na prvi na¢in dobicete dijalog (kao na slici gore), gde treba odrediti broj kolona (do 63), redo-
va (32767) i eventualno $irinu kolona, a preporucuje se (na komandno dugme AutoFormat) i njen automatsko for-
matizovanje kao na sledeéoj slici.

Ovaj dijalog se, za veé kreiranu tabelu, moZe dobiti preko menija na Tables Tabk AutoFormat..., a u njemu se, pored
izbora nekog od formata iz liste, moZe ukljuditi (iskljuciti) i opcije za:
e  primenu formatizovanja parametara kao §to je to u izabranom AutoFormat-u
(ivi¢ne linije, senc¢enja i boje u ¢elijama, boja karaktera i automatsko $irenja kolona prema sadrzaju najsire
celije);
e  primenu specijalnog formatizovanja (red/kolona u zaglavlju i poslednji red/kolona kao u AutoFormat-u) i
&esto se koristi kod sumiranja (Total)

Ako se nalazite u redu neposredno ispod neke tabele, MS Word vam neée dati moguénost ubacivanja tabele ve¢ re-
dova (§to je i normalno), ali ako Zelite da ubacite ba§ tabelu — ostavite prazan red (koristeé¢i <Enter>).
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KRETANJE KROZ TABELU | AZURIRANJE

Za prelazak u sledecu ¢eliju koristi se <Tab>, za vracanje u prethodnu ¢éeliju <Shift>+ <Tab>, a mogu se koristiti
i kursorski tasteri kao i u slu¢aju kretanja kroz tekst (narociti za vertikalno kretanje kroz tabelu). Kada se nalazite u
poslednjoj ¢éeliji tabele — pritisak na <Tab> taster daje novi red (po formatu isti kao prethodni), ¢ime je omoguéeno
brzo dodavanje podataka u tabelu, a ako ne Zelite ovu prednost trebalo bi da iz tabele izadete preko kursorskih stre-
lica ili klikom mi$em u neki tekst. Pozicioniranje miSem je jo§ lak$e — kliknite u ¢eliju koju Zelite.

Pritisak na <Enter> u ¢eliji tabele dovodi do njenog vertikalnog proSirenja, pa ée i ceo red tabele uzeti visinu ove
¢elije (jer je najvisa), a kako se ovim prelomom stvara nehomogenost tabele, treba ga izbegavati.

Da bi tabela bila uredena za unos podataka potrebno je da ima:
¢ najmanje jedno zaglavlje (uglavnom prvi red ili prva kolona);
e da ima isti format podataka po kolonama, odnosno redovima;
e fiksnu Sirinu kolona, odnosno redova, po kojima su formati podataka isti i
e da nema prazan red ni praznu kolonu.

Najcesdi slucaj je da se tabela ureduje za unos podataka dodavanjem redova, §to obavezno znadi da ima zaglavlje u
prvom redu i isti format podataka po kolonama, §to znaci na se npr. u prvoj koloni unosi tekst, u drugoj valutni iznos,
u tre¢oj datum, itd. Dodavanje kolona nije nemoguée, ali nije ni ovako fleksibilno.

SELEKTOVANJE REDOVA, KOLONA, CELIJA

Selektovanje reda, kolone ili cele tabele moZe se postiéi preko menija Table, gde postoje stavke: Select Row, Select
Column i Select Table, §to necete imati na raspolaganju kada se ne nalazite u nekoj tabeli.

Selektovanje reda tabele ne razlikuje se od nacina na koji selektujemo red teksta, dakle klikom ispred reda tabele
kada se pointer misa pretvori u strelicu (u smeru severo-istok).

Selektovanje kolone se obezbeduje ukazivanjem pointerom misa vertikalno iznad zaglavlja i kada se pojavi strelica
nadole dovoljno je kliknuti. Kombinacijom sa <Shift> tasterom moZe se obezbediti i selektovanje vise kolona. Ali,
najlaksi nacin selektovanija kolone je klik?® mi¥em u jednu njegovu celiju dok taster <Alt> drite pritisnut, §to mo-
Yete kombinovati u cilju selektovanja vise kolona.

Selektovanje jedne éelije se izvodi klikom misem ispred®® prvog znaka u toj éeliji (u ovom sluaju tekst u éeliji se
ponasa kao pasus), tako da trostruki klik miSem (u poslednji ako ih ima vise) u éeliju dovodi do selektovanja celog
sadrfaja u tekucoj celiji. Ako treba da selektujete blok ¢elija treba najpre da se pozicionirate u prvu, drZite taster
<Shift> pritisnut i pri tome pozicionirate se u poslednju ¢eliju bloka koji Zelite selektovati. Kretanje (u cilju pozici-
oniranja) moZete obaviti i preko kursorskih strelica ili samo klikom miSem.

Selektovanje cele tabelese obavlja dvostrukim klikom miSem u éeliju tabele, uz drzanje pritisnutog <Alt>, a moZe
se obaviti i klikom u sam gornji levi ugao tabele (kao na slici desno).

PROMENA DIMENZIJA KOLONA, REDOVA I CELIJA

Promena $irine jedne kolone u tabeli uti¢e na tabelu na sledeée nacine, i to:

1. Unutrasnje (bez uticaja na spoljne granice) — tako $to mifem ukaZemo na granicu izmedu teku-
¢e i sledeée kolone, pa kada se pointer miSa pretvori u dve strelice sa suprotnim smerom (levo-
desno), pritisnite miSem u granicu i pomerite je ulevo za suZenje, a udesno za proSirenje kolone.
Promena $irine ove kolone ¢e iéi na racun §irine sledeée (desne) kolonu.

2. Spoljasnje (sa uticajem na granicu tabele i njenu $irinu) — tako $to se promena $irine kolone
obavlja preko horizontalnog lenjira na postoje¢e markere (kao na slici).

napomene
% Dyostruki klik pri drZanju tastera <Alt> selektovacde celu tabelu.
% Ovo mote predstavljati problem kada je u sitnijem obliku prikaza, pa treba pove&axim.
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Promena visine reda se postiZe analogno promeni §irine kolone s tim da:

1. visinureda uvek povecavate i smanjujete pomerajuci njenu donju granicu;

2. koristite vertikalni lenjir;

3. promena visine reda uvek uti¢e i na visinu tabele;

4. visina reda se automatski podeSava prema Celiji sa "najvise" teksta, odnosno najvigoj éeliji tekuceg reda.
Promena visine ili §irine éelije je analogna gornjim postupcima s tim da:

1. celija mora biti selektovana (da promenom njene $irine ne bi bila obuhvaéena i tekuca kolona)

2. promena visine éelije automatski se odraZava na ceo tekuéi red

3. sve $to zamislite da izvedete sa ¢elijama (u smislu izgleda) lak3e i brze éete postiéi kori$¢enjem alata iz pa-

lete Tables and Borders, ali i preko PopUp menija za selektovani blok éelija.

Za detaljno podesavanje visine i Sirine Celija koristiti se dijalog Cell Height and Width, otvara se preko Tables> Cell
Height and Width, ima dve kartice (Row i Column) i izgleda kao na datim slikama.

UBACIVANJE | BRISANJE

Kada je potrebno da ubacite red, kolonu ili éeliju treba:
1. selektovati red, kolonu ili éeliju
(u skladu sa tim $ta Zelite da ubacite);
2. kliknuti desnim?’ tasterom misa u selekciju;

3. uPopUp meniju odabrati odgovarajuéu stavku Insert

Kod ubacivanja nove ¢elije potrebno je da jo§ odredite i nacin njenog ubacivanja:
Shift cells right pomeranjem ¢elija desno
Shift cells down pomeranjem ¢elija nadole
Insert entire row ubacivanjem celog reda
Insert entire column ubacivanjem cele kolone

Analogno ubacivanju moZe se izvrsiti i brisanje redova, kolona i ¢elija, ali je najlaksi nac¢in koriséenje tasterske pre-
&ice za Cut (<Ctrl >+X). Primetite da se preko tastera <Delete> brise samo sadr?aj u selektovanim éelijama, ako
selektovani blok ne obuhvata tekst izvan tabela, ali ako, uz selekciju u tabeli, selektujete bar jedan znak (slovo) van
tabele — modéicete deo selektovane tabele da obriSete (ukljucujudi éelije).

Ubacivanje ¢elija se ne savetuje u tabelu koja predstavlja organizovanu grupu podataka
(adresar, platni spisak i sl.), jer se na taj nadin moZe izazvati poremecaji u hijerarhiji tabele,
gde su polja (ime, prezime, adresa,...) definisana po kolonama, a slogovi podataka upisani
po redovima. Tako su podaci za "Petra Petrovi¢a" smesteni u vise Celija jednog reda, pa
ako, brisanjem neke ¢elije u tabeli, izvrSite pomeranje preostalih kolona na gore ili dole,
doci¢e do premestanja celija (i podataka) u pogre$an red. Manji poremeéaj se moZe naci-
niti pomeranjem preostalih ¢elija nalevo ili nadesno, jer ¢e u tom slu¢aju biti poremeceni
samo podaci u tekuéem redu, ali i vertikalno formatizovanje u tabeli.

napomene

27 . y s . o 3 . . T
Red i kdonu moZete selektovati i klikom na desni taster mi3a, pa ¢ete ubrzati rad oko njihovog ubacivanjisahja.
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TABLE MENU

U odnosu na prethodne verzije, Table meni (kao na slici desno) je znatno unapreden i sada mnogo korisniji, pa se
mnoge komande i podeSavanja mogu izvoditi i iz samog menija, $to je naro&ito pogodno za one korisnike koji imaju
problema sa selektovanjem delova tebele (redova, kolona, éelija).

Za detaljna podeSavanja parametara tabele i elemenata koji je ¢ine treba koristiti dijaloge koje ¢emo u nastavku opi-
sati.

TABLE PROPERTIES

PokuSavajuéi da,centralizovanjem svojstava objekata, omoguéi korisniku lak3e snala%enje u radu, Word omoguéava
da skoro sve parametre tabele moZete kontrolisati iz jednog dijaloga. Dijalog sadrZi kartice Table, Row, Column i Cell,
kroz koje se defini§u parametri za samu tabelu, redove, kolone i éelije (prikazano na slede¢im slikama).

U kartici Table, dijaloga Tabk Properties, mogu se podesavati parametri odnosa (uravnanja, pozicije) tabele i teksta,
gde su primenjena gotovo ista pravila, kao i za sam pasus (format paragrafa).

U kartici Row se pode$avaju parametri za selektovane redove ili tekuéi red s tim da se, bez izlaza iz dijaloga, mogu
definisati parametri i za ostale redove u tabeli.
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U kartici Column primenjen je sli¢an princip za kolone, dok se kartica Cell odnosi na éelije tabele.

Format paragrafa za tekst u ¢elijama moZe se podesiti preko dijaloga Cell Properties (kao na slici), gde je data i mogu-
¢énost da se sve to primeni i na sve Celije u tabeli (otvara se na komandno dugme Options).

Nesto sli¢éno moZe se primeniti i iz kartice Table na komandni taster Options, posle Cega se otvara dijalog Tabk Opti-

ons.

DIZAJN TABELE PREKO PALETE TABLES AND BORDERS®

Ovde najpre vredi pomenuti sortiranje (rastuce i opadajuée) i sumiranje, preko kojeg moZete na brz nacin.

Ostali alati sluze za:

Draw Table
Eraser

Line Style
Line Weight
Border Color
Borders
Shading Color
Merge Cells
Split Cells
Align

Tabk AutoFormat
Change Text
Direction

iscrtavanje grani¢nih linija;

za brisanje grani¢nih linija;

izbor vrste linije za granice;

debljine linije

boje linije;

poziciju grani¢ne linije (kao na drugoj slici)

boju popune éelije (kao na tre¢oj slici)

spajanje vise ¢elija u jednu (brisanjem granica izmedu njih)
deljenje jedne (ili selektovanog bloka ¢elija) na vise ¢elija
vertikalno poravnanje: Top — gore, Center — centralno ili Bottom — dole
pozivanje automatskog formatizovanja;

promena pravca ispisivanja teksta, gde pored uobicajenog moZete izabrati vertikalni ispis

teksta: vertikalno odozdo nagore i odozgo nadole.

26
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4] MS Word

Napredne tehnike azuriranja

PorPUP MENI

PopUp meni je alat profesionalnih korisnika, ali bez obzira na tu &injenicu ne predstavlja kompleksan alat za ko-
ri¢enje osnovnih akcija. Njegova najvecéa prednost u odnosu na sve duge alate za aZuriranje (i mnoge druge akcije)
je to §to se sadrZaj (stavke) ovog menija menjaju u zavisnosti od tipa selektovanog objekta nad kojim se podrazume-
va akcija.

Tako na primer:

ako selektujete deo teksta  ako ste selektovali éelije,

necete dobiti pristup ko-  u vaSem dokumentu dobi-  red ili kolonu tabele dobi- Allkada ste u dijalogu za

Insert ili Open moZete do-

mandama Cut i Copy ako ¢ete na raspolaganju éete proSireni PopUp meni L o )
) . o s .. biti i mnogo Sire mogud-
niste selektovali tekst: najéesée akcije nad tek- za ,
. nosti:
stom: akcije nad tabelom:

PopUp meni treba koristiti $to vise bez obzira na aplikaciju u kojoj radite, jer ete preko njega imati najbrzi pristup
mnogim akcijama, pa ¢ete vremenom sigurno isprobavati sve one koje niste koristili, a ovde su vam ponudene.
Najpopularniji programi za Windows nude i kombinaciju PopUp i Drag & Drop metode desnim tasterom misa, a mi
¢emo ovo obraditi uz opis Drag & Drop metode.

DRAG & DRoOP

E, ovo je veé nesto drugo. Primenom ovog postupka sigurno éete brzo i na najsigurniji i najkomforniji moguéi na¢in
vrsiti aZuriranja u dokumentu, a pored toga istu moZete primeniti u veé¢ini Windows programa, gde je u pitanju obra-
da teksta, grafike i sl. Ovom metodom je moguée: obrisati, kopirati, zalepiti, duplicirati, prebaciti, kreirati pre¢icu ili
hyperlink i sl. Preduslov kori$¢enja ove metode je dobra kontrola i stabilnost pri radu migem (kako pri poentiranju
tako i za vreme Click-a i desnog Click-a).
Drag & Drop se preko "levog" tastera mifa (na kom je kaZiprst) moZe izvrsiti kroz sledece akcije:
1. selektujte jedan ili viSe objekata (u naSem slucaju: pojedinacni karakteri, re&i, reCenice,
pasusi, deo dokumenta ili ¢ak ceo dokument) na neki od na¢ina prikazanih u prethod-
nim temama;
2. pomerite miSa (bez pritiska na tastere) dok se pointer ne pretvori u strelicu u smeru se-
vero-zapad,;
3. pritisnite levim tasterom u selekciju i odvucite je (uz drZanje pritisnutog tastera) na ne-
ko drugo mesto u istom ili drugom (vidljivom) dokumentu;
4. pratite virtuelnu vertikalnu linijui otpustite taster misa kada ona bude na mestu gde
Zelite da prebacite selektovani deo dokumenta.
Ako pri istoj akciji Zelite da kreirate kopiju (duplikat selektovanog dela dokumenta) potrebno je da, pre otpuStanja
tastera miSa, zadrZite pritisnut <Ctrl> taster (uz pointer misem ce se pojaviti mali znak +.
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Koris¢enjem desnog tastera misa pri Drag & Drop neée imati dilemu o tome da li primenjujete Copy, Move ili nesto
trece, jer posle otpuStanja na novoj lokaciji dobijate PopUp meni u kojem moZete odabrati ili otkazati akciju. Uz sve
to Drag & Drop metoda ne koristi Clipboard veé Windows OLE moguénosti, pa ako veé nesto ¢uvate kopirano preko
Clipboard-a bi¢e netaknuto. Dakle kombinujte kopiranje Dragé&Drop sa kopiranjem preko Clipboard-a

KONTROLA PRAVOPISA @

Da biste lakse uodili pravopisne greske i ispravljali ih prema predlozima MS Word-a, potrebno je da MS Word-u date
do znanja na kom je jeziku taj tekst unet — zato obeleZite pasus ili (sa <Ctrl>+A) ¢itav tekst, izaberite Tools> Lan-
guage» Set Language, a onda Serbian (Latin)?%; nema prepreke da deo teksta bude pisan jednim pismom, deo drugim,
a da ostatak bude na engleskom. Word ée automatski pozvati odgovarajué¢i modul za kontrolu pravopisa i prijaviti
greSke na koje naide. Pri promeni kodnog rasporeda tastature kojom unosite tekst Word otkriva u kom jeziku unosite
(8to je i prirodno), pa ¢emo imati problema ako koristimo Slovenian tastaturu, a ne Serbian (Latin) ili Serbian
(Cyrillic). Sve ovo se oslanja na multijezi¢ku podrsku vaseg Windows-a, pa ako je nemate ovo i ne pokusavajte.

PODELA NA sLOGOVE @

Podela na slogove funkcionise sjajno — selektujete tekst, izaberete Toolss Language» Hyphenation, "overite" automat-
sku hifenaciju i vi$e ne mislite na nju — tekst ¢e kona¢no imati lepo uravnatu desnu ivicu, izmedu re&i se necée
pojavljivati ogromni razmaci i, §to je najvaZnije, odmoricete se od raznih pred-hifenacija.

Sve §to vam je potrebno u vezi pravopisa i podele na slogove moZe se instalirati i vaZi za sve aplikacije Microsoft Of-
fice-a Excel, PowerPoint, Access, ...

Oblici prikaza dokumenta

NAJCESCI OBLICI PRIKAZA DOKUMENTA

Svi oblici prikaza dokumenta se mogu aktivirati preko odgovarajuéih stavki menija View, ali i preko 4 mala koman-
dna dugmeta u levom uglu horizontalnog kliza¢a (donji levi ugao prozora aplikacije).

Normal — U Normal pogledu na dokument necete videti graficke objekte u njemu, ali ¢ete zato imati pun i bolji uvid
u sam tekst. Ovaj pogled se obi¢no koristi: na po¢etku unosa teksta, u situaciji jednostavnijih i kraéih dokumenata,
pregleda, aZuriranja i formatizovanja samo tekstualnog dela veéeg dokumenta i dr.

Mnogi ga korisnici izbegavaju ovaj pogled jer im se Cesto desi da u Stampi dobiju "nesto drugaciji" izgled dokumenta,
$to se obi¢no vezuje za margine, fusnote i graficke objekte.

Page Layout — U ovom pogledu vidljive su granice papira, a omogucen je i pogled na vise strana istovremeno i (za-
visno od izabranog Zoom-a), dobar uvid u prelom teksta kroz ceo dokument, odnos teksta i grafike, strani¢ne oznake
i format papira (skoro kao u Stampanom pogledu). Ovaj oblik pogleda koristi vie sistemske memorije, skrolovanje
kroz dokument moZe biti znatno usporeno, posebno u sluéaju kada dokument sadrZi veliki broj grafickih objekata i
kompleksna formatizovanja.

Desava se da u MS Word-u ne moZete da iskoristite vi§e od 6-7 vrsta fontova, jer vam daje
poruku kao "Too many formatting..." . Problem se krije u velikom zauzeéu sistemske me-
morije ili losem izboru fontova, pa problem moZete refiti zatvaranjem svih programa koji
koriste sistemske resurse, odnosno instaliranjem novih (standardnih) vektorskih TT fon-
tova.

Header and Footer — Ovaj pogled je namenjen za pristup a%uriranju Header-a (zaglavlja), Footer-a (podnoZja), broje-
va strana i ostalih strani¢nih oznaka. Do ovog se pogleda moZe do¢i i preko dvostrukog klika u Header ili Footer (us-
lov je da u ovim delovima dokumenta postoji prethodno unet tekst).

napomene

2 Akou listi jezika imate samo Serbian (i to mo?da dva putaSerbian (Latin) je onaj drugi u nizu (zbog AB@nog sortimnja).
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Zoom — Preko View» Zoom MS Word daje moguénost detaljnog pode$avanje tekudeg zumiranja (uveéanja-
umanjenja), ali se jednostavnije moze zadati preko ComboBox-a Zoom u Standard paleti alata, gde se lako uocava po
procentualnom obliku prikaza uveéanja. Zoom od 100% se smatra odnosom 1:1, ispod 100% su umanjenja, a preko
uveéanja dokumenta samo za pregled. Da biste tekst u dokumentu videli krupnije najc¢e3ce je potrebno izabrati veéi
Zoom, a ne menjati veli¢inu Font-a, §to se poCetnicima ¢esto de$ava. Da li je veli¢ina slova odgovarajuéa zavisi od
vrste dokumenta i njegove Citljivosti, dok Zoom moZete birati prema trenutnim zadacima u obradi i pregledu duku-
menta. Pokusajte da veé pri prvom kori§éenju View i Zoom alata uocite razliku medu njima.

OUTLINE®D

Ovaj pogled na dokument pruza izuzetne moguénosti u pregledu strukture po zadanim naslovima, kao i njihovog
premestanja po vertikalnoj ili horizontalnoj hijerarhijskoj strukturi. Ovim se pregledom najlakse pronalaze i isprav-
ljaju greske u strukturi naslova i preporucuje se za koriséenje tek uz primenu stilova, jer u suprotnom dokument ne-
ma nikakvu strukturu niti se njegova hijerarhija moZe prikazati na prvi nacin.

DocuMENT Map®

Pregled koji sam govori o sebi. Kada ga ukljuc¢ite dobiéete s leve strane (prozora dokumenta) dodatni panel sa kom-
pletnom strukturom tekuceg dokumenta. Rad u ovom pregledu éete najbrze savladati, jer je intuitivan i u potpunosti
odgovara izgledu i kori$éenju levog panela u Windows Explorer-u. U ovom panelu su prikazani naslovi kroz doku-
ment (pod uslovom kori$éenja stilova), pa ¢ete lako (klikom na desni taster misa) izabrati broj nivoa koje treba pri-
kazati, razgranati strukturu (na +) ili skupiti (na -), ali i pozicionirati se (veoma brzo na bilo koji naslov u
dokumentu) kliknuvsi na naslov u panelu.

Stranic¢no formatizovanje dokumenta

PARAMETRI STRANE — PAGE SETUP

Preko ovog servisa (File» Page Setup) se definiSe veli¢ina i oblik prostora za tekst, a glavni parametri ovde su: veli¢i-
na i poloZaj papira i margine. Kao $to se to na prvo slici vidi — moguée je zadati format strane samo za neki deo do-
kumenta (sekciju ili selektovani deo) ili globalno za ceo dokument. Margine se mogu pode§avati neposredno pre
Stampanja, ali kako se ovim u mnogome uti¢e na prelom teksta, savetuje se da, na novom dokumentu, ove paramet-
re definiSete $to pre.

Margine su prostori koji se ostavljaju prazni izmedu teksta i ivice papira. lako postoji vise na¢ina za definisanje mar-
gina ipak je to najbolje raditi preko dijaloga Page Setup u kartici Margins, gde se zadaje: gornja, donja, leva (ili unut-
ra$nja), desna (ili spolja$nja), prostor za korienje, prostor za Header i Footer, kao i efekat ogledala (dvostrana
publikacija). Stavka Mirror margins daje moguénost formatizovanja strane u obliku ogledala (razlikovanjem neparne
i parne strane), $to se koristi u svakoj ve¢oj publikaciji.

Veli¢ina papira se zadaje u kartici Paper Size, gde se pored ponudenih formata mogu zadati i proizvoljne dimenzije
papira, a papir se dufom stranom moZe orijentisati uspravno (Portrait) ili oboreno (Landscape).

Kada je u pitanju kompleksniji dokument, tada je i kartica Layout izuzetno vaZna jer se u njoj definise: oblik prekida
koji se u dokumentu smatra kao pocetak nove sekcije, razli¢ito zaglavlje parnih i neparnih strana, izuzece prve stra-
ne od unetih zaglavlja, vertikalno poravnanje teksta na strani, kao i (definisano) numerisanje linija (redova) kroz
dokument.
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PODRAZUMEVANI PARAMET RI STRANE
Da biste zadrzali iste parametre strane pri kreiranju svakog novog Word dokumenta (istu veli¢inu papira, margine i
dr.) uradite sledece:

1. otvorite dijalog Page Setup

2. ukartici Margins podesite margine na one vrednosti koje najc¢e3ce koristite (npr. prve Cetiri na 2

cm)
3. ukartici Paper Size podesite veli¢inu papira na A4 i orijentaciju na Portrait
4. kliknite na komandno dugme Default, pa na dobijenu poruku odgovorite sa Yes.

STRANIENA NUMERACIJA

Brojevi strane se ubacuju preko Insert» Page Numbers, ¢ime se dobija dijalog kao na slici u kome treba zadati:
1. njihovu poziciju (vrh ili dno strane)
2. uravnanje (levo, desno, centralno, iznutra ili spolja)
3. ukljuciti ili iskljuciti prikaz broja na prvoj strani
4. detaljno podesiti format ispisa brojeva strana preko komandnog dugmeta Format. ..
Detaljno podesavanje podrazumeva moguénosti:
e izbor brojevnih, slovnih i kombinaovanih oznaka broja strane,
e ukljucivanje oznake rednog broja tekuceg naslova i simbola za odvajanje od broja strane i
e nastavak numeracije kao nastavka iz prethodne sekcije ili od specificiranog broja strane (koji moZe biti iz op-

sega 0 do 32760).

HEADER AND FOOTER

Prelazak u pregled ovih parametara dokumenta je omoguéen preko menija View»Header and Footer ili dvostrukim
klikom na Header ili Footer, kada je on veé kreiran. Kada Zelite da izadete iz ovog re¥ima, moZete dvostruko kliknuti
na osnovni dokument ili iskoristiti ekranski taster Close na vidljivoj paleti.

Nema valjane publikacije bez Header-a i Footer-a, koji predstavljaju objekte ¢ije se ponavljanje na svakoj ili naizme-
ni¢nim stranama podrazumeva, kao §to su stilizovani tekst, brojevi strana, ime autora, datum, naslov poglavlja, i sl.
Najcesdi sluéaj je da su Header i Footer isti kroz ceo dokument, ali se mogu kreirati i razli¢iti po sekcijama.

Kretanje kroz Header i Footer se najlakSe postiZe preko tastera <PageUp> i <PageDn>, ali se mogu koristiti i kur-
sorske strelice, dok je aZuriranje isto kao u bilo kom drugom delu dokumenta.

Ako vam se delovi Header-a i Footer-a poklapaju sa naslovima i pasusima iz glavnog dela
dokumenta trebalo bi da povecate vrednosti za Top i Bottom margine ili smanjite vrednosti
za visinu Header-a i Footer-a, pa ¢ete izmedu navedenih delova dobiti veéi prostor.

Tekst u Header-u se obi¢no ogranic¢ava linijom (Borders) sa donje strane, a Footer sa gor-
nje. U Header i Footer ne treba trpati sve i svaSta veé se zadrZati na jednom unetom redu
teksta uz eventualno kombinovanje sa jednim ili dva grafi¢ka objekta kao logotipa.

30 MS Word - Strani¢no formatizovanje dokumenta



R S. Mikanovié

FOOTNOTE — ENDNOTE

Futnote i Endnote sluZe za bliZa objasnjenja, komentare ili upuéivanja na neku referencu u istom dokumentu. Fusnote
se sme§taju na istoj strani na kojoj se nalazi i njen marker (obi¢no uz neku re¢), dok se endnote smestajuna kraj te-
kuéeg odeljka. Za ubacivanje fusnote ili endnote treba zadati Insert» Footnote, ¢ime se dobija moguénost njenog bli-
Yeg definisanja (kao na slici desno), gde se moZe izabrati njen tip i oznacavanja — brojevima (preporucljivo) ili
simbolima.
Fusnota se uglavnom ubacuje na kraju neke reci (na koju se odnosi i koju bliZe opisuje), posle ¢ega MS Word:
1. na to mesto ubacuje sledeéi slobodan broj za fusnotu (ili birate neki simbol),
2. postavlja liniju deljenja izmedu teksta u dokumentu i fusnote;
3. prebacuje kursor u deo ispod ove linije i daje moguénost da tekst odnosne
fusnote otkucate;
4. daje moguénost da se dvostrukim klikom na broj (simbol) fusnote u tek-
stuili fusnoti prebacite na suprotnu poziciju.
Fusnota se briSe jednostavnim brisanjem njene reference u samom tekstu gde je ubacena. Ako se nalazite u Normal
prikazu dokumenta — dobiéete poseban prozor (u dnu ekrana) gde moZete lakSe aZurirati tekst u fusnotama, a ako ni-
je vidljiv otvorite ga preko View»Footnotes.
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[5] MS Word

Ugradeni stilovi i njihova primena

UOPSTE O STILOVIMA

Stilovi, jedan od glavnih razloga velike popularnosti MS Word-a, su skupovi parametara za formatiranje karaktera i
pasusa, koji se ¢uvaju kao delovi samog dokumenta. Stilovi se mogu u praksi lakse prihvatiti i razumeti kao "kalupi
za oblikovanje". Kori§¢enjem stilova se omogucava brzo i lako formatizovanje u situaciji kada na viSe mesta u do-
kumentu treba primeniti formatizovanje sa istim parametrima (bilo karaktera ili pasusa), ali se pored toga postiZe
izuzetno visok stepen fleksibilnosti dokumenta na promene. Neki oblici prikaza dokumenta neée imati efekta (svi
koji treba da prikaZu strukturu — Document Map i Outline), ako kroz dokument nisu primenjeni stilovi.

Pregled (standardno ugradenih) stilova se moze dobiti u ComboBox-u Style (na samom pocetku palete Formatting —
kao npr. na slici desno), gde se nalaze koris¢eni stilovi, dok se drfanjem tastera <Shift> prilikom otvaranja — dobija
lista svih postojecih stilova (bilo da su iskoriséeni ili ne). Otvaranje ove liste moZe potrajati, jer Word ima zadatak da
vam u listi prika%e primer teksta formatizovanog u ovom stilu, gde se koriste upravo imena odnosnih stilova. Pored
toga, sa desne strane se u svakoj stavci liste, prikazan i:

e znak koji indicira oblik horizontalnog poravnanja koji je u stilu kori$éen;

e znak T ili @ koji ukazuje da se dati stil odnosi na format pasusa, odnosno format karaktera;

e broj kojim se ukazuje na veli¢inu fonta u ovom stilu.

PRIMENA UGRADENIH STILOVA

Najprostiji nain primene nekog ugradenog stila je preko ComboBox-a Style, gde je potreban samo klik na izabrani
stil. Ali, kako MS Word sporo otvara ovu (graficku) listu pokugajte da potpuno izbegnete njeno otvaranje. Kada usa-
vrsite va§ rad u MS Word-u sigurno je da ¢ete imati i viSe koris¢enih stilova i da éete ovaj ComboBox otvarati tek da
pogledate koji od stilova moZete primeniti, ali ¢ete primenu stila na vasu selekciju uvek raditi preko tastature (neu-
poredivo br¥e).

Stilovi koje ¢ete najéescée koristiti (i bez kojih neéete moéi) su:
Normal — <Ctrl>+<Shift>+N  (uobi¢ajen i najceséi pasus)

Heading 1 — <Cul>+<Alt>+1 (naslov prvog nivoa)
Heading 2 — <Cul>+<Alt>+2 (naslov drugog nivoa)
Heading 3 — <Ctrl>+ <Alt>+3 (naslov tre¢eg nivoa)

List Bullet — <Ctrl>+ <Shift>+S (nabrajanja simbolima)

Primena stila na odnosni pasus ima istu logiku kao i formatiranje pasusa (pasus ne mora biti selektovan), dok se stil
za karaktere primenjuje analogno formatiranju karaktera (mora se selektovati nekoliko slova ili re¢i). Kada selekciju
ne odredite — stil karaktera se primenjuje na trenutnoj poziciji kursora ¢ime se (nastavljanjem sa unosom teksta) do-
bija njegova primena i u nastavku dokumenta.

PROMENA PARAMETARA ST ILA - MODIFIKOVANJE

Ako ste na va$ deo teksta primenili neki od stilova, a ne svida vam se kako on izgleda, trebalo bi da otvorite dijalog
Style preko Format» Style, (kao na slici desno), pa odabrete komandno dugme Modify, ¢ime ulazite u Modify Style —
glavni dijalog za modifikaciju tekuceg stila (koji ste odabrali u prethodnom dijalogu).
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U ovom dijalogu vam je na raspolaganju lista stolova, pa u zavisnosti od liste stilova koju ¥elite da vidite, moZete
izabrati: Styles in use - samo koris¢ene stilove, All styles - sve stilove ili User-defined styles - korisni¢ki definisane stilo-
ve. U korisni¢ki definisane stilove se ubraja svaki stil kojem vi dodelite ime, kao npr. "Glavni naslov", "Naslov",
"Nepomena',... i ne savetuju se za §iru primenu, jer oteZavaju primenu naprednih tehnika u prelomu teksta (Style
Gallery, Master Document), koje zahtevaju svojevrsnu standardizaciju u dodeli imena stilovima.

U dijalogu Modify Style na raspolaganju sledeéi parametri:

Name | ime stila

Based On | stil na kome je tekudi stil baziran
(¢ije parametre preuzima dogradujudi na njega sopstvene)

Style Type | stil za pasus ili za karaktere

Style for | stil koji sledi teku¢i (moZe se koristiti samo za stilove tipa paragraf), ¢ime se omo-
Following | gucuje automatsko zadavanje formata sledeceg pasusa posle zavrietka tekuéeg
Paragraph | Primer dobro odredenog osnovnog redosleda stilova je:
Heading 1- Heading 2 — Heading 3 — Normal

i zadaje se pojedina¢no modifikovanjem svakog od navedenih stilova

Add to | dodavanje (odnosno popravka) modifikovanog stila u izvorni $ablon Ne savetuje
Template | se dok ne ovladate kori§¢enjem Sablona (Templates).

Format: | izbor nekog od pristupa formatizovanju, ¢ime se dobijaju uobicajeni dijalozi: Format
Font, Format Paragraph,...

Shortcut Key... | izbor tasterske precice za primenu stila (na selekciju ili tekuéi pasus), gde se mogu,
pored postojecih, uvesti i druge (sve se obavlja u dijalogu Customize Keyboard kao
na slici desno)

Uvodenje tasterskih precica nije tesko, ali ¢ete od ovoga imati veliku korist (ubrzanje poslova na formatizovanju
dokumenta), ali vodite ra¢una da kao tastersku precicu ne zadata neku od onih koje su cesto koriéene (npr.
<Ctrl>+C i sli¢no), a komentar o tome za §ta se tekuca precica koristi — moZete videti neposredno ispod polja za
unos precice.

SAVET
Brzi nacin da modifikujete neki stil (osim stila Normal) sastoji se iz sledeéih koraka:

1. posto ste primenili stil (njegovo ime je vidljivo u ComboBox-u Style) koji vam se ne dopada mo-
difikujte ga primenom uobi¢ajenih dijaloga i moguénosti formatiranja sa palete (bez ulaska u
Format Style dijalog);

2. kada budete poZeleli da tekudi stil izgleda bag kao §to izgleda selektovani tekst (uglavnom je to
pasus) — selektujte ceo pasus (npr. trostrukim klikom), pa zatim kliknite U IME?® tekuceg stila u
ComboBox-u Style;

napomene

29 . . . . . 3 o ) ) 1 ) .
Prilikom ovogklika mifem pazite da ne otvarate listu, veé se pozicionirajte u samo ime stila (moZda éete morati malo delpate dok se e-
lo ime selektujte, ali budite strpljivi isplati se.
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3. kadase ime stila osenci (ili ekranski kursor primetite izmedu dva slova u imenu) — pritisnite
taster <Enter>, posle ¢ega éete dobiti umanjeni dijalog Modify Style(kao na slici desno), gde
treba da:

* overite opciju Update the style to reflect changes, ako ste "mislili ozbiljno", pa ée kroz ceo
dokument ovaj stil biti modifikovan (podrazumeva se);

* overite opciju Reapply the formatting of the style to the selection, ako ste "se $alili",

pa ¢e selektovani pasus biti u potpunosti vraéen na format stila koji mu je dodeljen (ponistava
se uvedena modifikacija);

* opciono uvedete Automatically update the style from now on, ako Zelite da se ovaj stil
automatski modifikuje posle formatizovanja u pasusima koji se na njega referenciraju (savetuje
se SAMOQO za stilove nabrajanja i neke specifi¢ne oblike formatizovanja kao §to su Footer,
Header,..., jer obavezno dovodi do nekontrolisanog formatizovanja).

4. potvrdite izabrano na OK ili otkaZite na Cancel.

PRIMENA TEME @

Primenjuju¢i dokazane alate u svom programu za Web dizajn - Front Page, Microsoft je i ovde (u Word-u) dao na ras-
polaganje formatizovanje dokumenta primenom tema. Sve ¢e funkcionisati lepo pod uslovom da su kroz dokument
primenjeni (pomenuti) standardni stilovi Heading1, Heading2, Heading3, ...

Teme su znatno primenjivije kod dizajna Web prezentacija, ali i ovde mogu pomodi.

Style Gallery je najbolji alat za preformatizovanje celog dokumenta prema veé postoje¢em $ablonu (dokumentu), a
znatno moZe ubrzati rad na obradi publikacija i bez obzira na veli¢inu dokumenata. Kako je ovaj alat dosta sloZeniji,
obraduje se na visem kursu Word-a.

Prelom teksta

PRIMENA | VRSTE PRELO MA

Tekst u kontinuitetu, od prvog do poslednjeg reda, u DTP programima se sree veoma retko, jer — ako teksta u do-
kumentu ima viSe od jedne strane ili jednog stupca — ve¢ se namece potreba za prelamanjem (nekim vidom odvaja-
nja, cepanja, podele i sl.). Dokument bez uvedenih preloma je tesko kontrolisati (kretati se kroz njega, aZurirati ga i
formatizovati). Cilj preloma je "kompaktnost" sekcije (odeljka), a ne dokumenta, ¢ime se sekcijama zasebno omogu-
¢ava unutra$nja celovitost.

Ako Zelite da vidite markere preloma u dokumentu — ukljucite vidljivost paragrafa na ko-

mandno dugme palete Formatting ili preko tastature na <Ctrl>+(.

Sve ovde receno za sekciju moZe se odnositi i na pasus, jer je pasus osnovni objekat pre-

loma dokumenta.

U dobro prelomljenom dokumentu neéete imati problem da "na prvu stranu ubacite jo§ jedan pasus teksta, pa da se
to odrazi na pomeranje teksta sve do 10-e strane", a da i ne pominjemo pomeranja na poslednjoj ($ta mislite kako to
izgleda u dokumentu koji ima 50-ak strana).

PRELOM ODELJKA®

Manuelni (ru¢ni) prelomi, koje u dokumentu treba primeniti jo§ pri unosu teksta (poredani od najc¢eséih do najre-
dih), su:

e prelazak u novi red istog pasusa, <Shift>+ <Enter>,

e prelazak u novi pasus,<Enter>,

¢ prelom na novu kolonu, <Ctrl >+ <Shift>+ <Enter>,

¢ prelom na novu stranu, <Ctrl>+ <Enter>.

34 MS Word - Prelom teksta



R S. Mikanovié

Novi odeljak ili sekcija u Word dokumentu zapo&inje se jednim od sledeéih preloma preko Insert»Bredk...:
o prekid strane na slede¢u
¢ prekid kolone
e prelom na parnu stranu i

o prelom na novu stranu,

dok se uredenjem zaglavlja strana, kao razli¢itih zaglavlja na pamim i neparnim stranama stvara globalna podela
dokumenta na dve sekcije vezane samo za strani¢ne oznake — tzv. Mirror (efekat ogledala) za dvostranu §tampu tek-
sta.

VISESTUBACENI PRELOM @

Prelamanje teksta u viSe kolona je uobi¢ajen kod kompleksnijih dokumenata i novinskog sloga, a u MS Word-u mo-
%e se zadati na taj nacin $to se prethodno selektuje deo teksta koji se prebacuje u visestubacni®®, pa zatim izabere
Format» Columns, posle ¢ega se dobija dijalog, kao na slici »

Ovde se korisniku daje moguénost da izabere jedan od 5 predloga podele na kolone (koji sluZi samo kao osnova za
dalje podesavanja), pa zatim izabere:
Numbers of columns broja kolona;
Line between prikaz linije deljenja kolona;
Width and spacing detaljno podesavanje §irine svake kolone i prostora izmedu njih;
Equal column width jednaku Sirinu svih kolona;
Apply to primena na tekucu selekciju (This section)ili od tekuée pozicije nadalje kroz dokument
(This Point Forward)
Start new column prebacivanje narednog teksta u vrh nove kolone (samo za slu¢aj da je Apply to prebace-
no na This Point Forward)

Kada selektujete tekst za prelom u vise stubaca obavezno selektujte celine pasusa, jer njihovo deljenje kroz vise ko-
lona moZe izgledati ruzno i nefunkcionalno u slu¢aju dokumenta koji ée se jo§ aZurirati. Za dobru kontrolu viestu-
bacnog preloma, kao uostalom i uopste za preloma teksta kroz dokument — najvaznije je PRE SVEGA ovladati do
savrienstva formatiranjem pasusa (Format» Paragraph)

napomene

30 RPTE v . . o
Najéeséi je dvostubani prelom sa jednakom $irinom kolona.
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PRELOM SA GRAFICKIM O BJEKTIMA®D

Veoma je tesko uraditi interesantnu i vrednu publikaciju bez grafickih objekata. MS Word nudi moguénost ubaciva-
nja slika svih formata (Insert» Picture), kao i ubacivanje objekata (Insert» Object) koji e se aZurirati u samom doku-
mentu ne izlazeéi iz programa.

Pri samom ubacivanju grafi¢ckog objekta Word nudi i razne graficke dodatke, kao $to su: Microsoft Office Clipart, di-
jagram preko MS Graph-a, jednostavne graficke elemente i oblike MS Drawing itd. (kao na slici desno), ali se naj-
&e’ce koristi ubacivanje obradene slike (From File).

Preduslov lakog i brzog upravljanje kompleksnim dokumentima sa grafi¢ckim objektima, pored preloma strana i ko-
lona, je formatizovanje (parametri) grafickog objekta, tj. njegovog odnosa prema tekstu u kojem treba da se nalazi,
$to se obraduje na visem kursu.

Izborom stavke From File dobicete dijalog slican Open dijalogu (slika dole), gde je pored uobicajenog data mogué-
nost tzv. veze na fajl (Link to File) ¢ime se ostvaruje samo veza, a ne i bukvalno ubacivanje objekta u Word doku-
ment.

Ubacivanje objekta preko Link to File ima prednosti:
e povezivanje vife raznorodnih objekata u jedan Word dokument;
e ajuriranje objekta moZe vrSiti i drugi korisnik
(slu¢aj lokalne ra¢unarske mreZe), a promene se gotovo istovremeno odra%avaju i na dokument u koji su uba-
&ene linkom;
e rapidan razvoj jednog ili vise dokumenata male veli¢ine
(objekti se ubacuju posredno pa nisu sastavni deo dokumenta mada tako sve izgleda);
e moguénost visokog stepena organizacije grupe korisnika na brzoj izradi publikacije i projektne dokumentaci-
je,...
Loga strana Link to File povezivanja je to $to je oteZano kopiranje ovakvog dokumenta, jer MS Word definie samo
apsolutne staze prema povezanim objektima, pa se takav dokument, raden kroz mreZu, gotovo ne moZe preneti na
drugu lokaciju bez rekonstrukcije (¢ime se ponovo zadaju staze prema povezanim objektima)
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6] MS Word

Automatsko kreiranja dokumenata - cirkulari

POJAM CIRKULARA | PRI MENLJIVOST

Kada isti dokument, sa minimalnim izmenama u podacima primaoca, treba poslati na veliki broj adresa — u pitanju
je tzv. cirkularna posta ili cirkularno pismo. Nije obavezno da dokument bude u formi pisma, §to éemo kasnije i vide-
ti.

Ovo je jedan od veoma &estih zadataka u kancelarijskim i administrativnim poslovima, i ne samo u njima, a uzece-
mo za primer turisticku agenciju Sunlink — koja je dobila posao na organizovanju seminara "Informatika u menadz-
mentu" koji e se odrZavati na svakih 6 meseci, u nekom gradu nase zemlje. Pored ostalog, Sunlink ima obavezu da
dva meseca pre svakog seminara poSalje obaves§tenja (o temama koje ¢e na seminaru biti prezentirane), kako pose-
tiocima prethodnog seminara i pretplatnicima na "Bilten" seminara, tako i svima koji su se interesovali ili prijavili,
sve u svemu oko 350 dopisa.

Dakle, Sunlink ée imati puno posla!? NE. Oni znaju kako se to brze radi.

Klasi¢an nacin bi za reSenje ovakvog problema podrazumevao da brzo znate da kopirate i lepite tekst, dakle i da brzo
kucate. Za ovakve i sli¢ne poslove, MS Word je ponudio servis pod nazivom Mail Merge, pa vam nede biti potrebno
veliko umecée da sve efekte postignete za neverovatno kratko vreme.

KREIRAJTE RADNI DOKUMENT (A)

Radni dokument je u ovom slu¢aju tek jedan od primeraka dopisa koji treba da se posalje, pa ga treba uneti u obliku
dopisa jednom klijentu. Kako ¢e se u njemu razlikovati neka polja podataka vezana za klijente — to bi trebalo da sa-
gledate veé na pocetku.
Otvorite glavni dijalog na Tools» Mail Merge, posle &ega ¢éete dobiti dijalog (kao na slici desno) gde vam MS Word
daje do znanja da proces kreiranja cirkularne poste ima 3 koraka i to:

1. kreiranje radnog dokumenta u Cetiri oblika: pismo, nalepnice, koverte i katalogki pregled,;

2. uzimanje podataka iz izvora i

3. spajanje radnog dokumenta i izvora u tre¢i dokument.
U ovom koraku izaberite Form Letters, pa ¢ete dobiti pitanje kao na sledeéoj slici,
gde treba da izaberete opciju Active Window, jer ste ve¢ kreirali dobar deo dokumenta.
Zatim treba da iz koraka 2 izaberete:

Create Data Source ako izvor podataka nemate ili

Open Data Source ako izvor veé imate,
pa Cete u slu€aju da kreirate izvor podataka dobiti moguénost da zadate imena poljima podataka, kao na sledece dve

slike.
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KREIRAJTE IZVOR PODATAKA (DOKUMENT B)

Izvor podataka moZe biti: tabela u Word dokumentu, tabela u MS Excel-u, baza podataka MS Access-a i mnogi drugi
oblici organizacije podataka (najé¢esce tabelarno).

Imena polja koja dobijete kao predloge moZete da uklonite preko komandnog dugmeta Remowe Field Name, dok une-
to ime polja moZete dodati u listu preko komandnog dugmeta Add Field Name.

Promenu redosleda polja moZete vrsiti na Move tastere (gore dole) sa desne strane liste uvedenih polja.

Pri imenovanju polja treba da postujete sledeéa pravila:
1. ime polja mora da po¢ne slovom i ne moZe biti duZe od 40 karaktera,
2. ime polja ne sme da sadr?i nikakve specijalne znake (zagra-
de, upitnike i sl) veé samo slova i brojeve
(dozvoljeni su znaci kao §to je tacka i znak podvlacenja
dok je blanko zabranjen);

nn

3. mogu se koristiti i sva slova ¢irilice i latinice pod uslovom korisé¢enja kodnog rasporeda YU (S1/Sr/Hr)

tastature, ali nikako YUSCII.

Po zavretku definisanja imena svih polja koja ste Zeleli, MS Word ¢e vam predloZiti da izvor sacuvate kao Word do-
kument (dokument sa tabelom), a kada to obavite preko dijaloga Save As (kao na slici desno) postaviée vam novo
pitanje — da li Zelite da: aZurirate izvor podataka Edit Data Source ili aZurirate glavni dokument Edit Main Document,
pa se vi odlucite za prvo, da bi uneli podatke u izvor.

Sada éete dobiti lepu formu za unos podataka u izvor u kojoj je rad izuzetno jednostavan. Za unos podataka je dovo-
ljno da koristite popunjavanje polja (sa imenima kako ste ih i uneli) i taster <Enter> za prelazak u sledece polje i
novi slog podataka.

Za kretanje kroz polja (u slu¢aju njihovog veéeg broja) koristite kliza sa desne strane, a za kretanje kroz slogove po-
dataka moZete koristiti navigacione tastere u donjem levom uglu forme ( gde je prikazan i broj tekuéeg sloga). Slog
podataka se dodaje preko komandno dugme Add New, brie preko Delete, traZi preko Find, a izvorni dokument se
moZe otvoriti preko View Source.

Posle ovih akcija dobiéete vidljivu paletu Mail Merge (kao na slici) preko koje ¢ete moéi da obavite skoro sve poslo-
ve vezane za cirkular.

Po zavrSetku aZuriranja izvora podataka kliknite u komandno dugme OK.
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Sada bi trebalo da, na mesta gde ste uneli primer podataka (prezime, ime,...) ubacite polja koja se uzimaju iz izvora
podataka i to tako §to: selektujete polje u radom dokumentu, pa otvaranjem liste polja preko komandnog dugmeta
Insert Field Name (iz palete Mail Marge, koju ste upravo dobili) kliknite u ime polja koje se vam treba iz ove liste.
Prodite kroz ceo radni dokument i na isti nacin ubacite sva potrebna polja podataka zamenjujuéi prethodno unete
eksperimentalne podatke. Uvek pokusajte da selektujete re¢ (ili podatak) gde éete ubaciti polje iz liste i izbegavajte
selektovanje oznake kraja pasusa.

Zaglavlje vaSeg radnog dokumenta bi trebalo da izgleda kao na prethodnoj slici, gde su ubacena polja osencena.

KoNAENO — C DOKUMENT

Kada smo kreirali radni (glavni dokument A) i izvorni (B), definisali mesta u dokumentu A, gde ¢e biti ubadeni po-
daci iz dokumenta B, jo§ nam je preostao samo 3, korak u servisu Mail Merge, a to je ... Merge, pa u¢inimo to preko
menija (Tools» Mail Marge» Merge (pod 3) ili preko palete Mail Merge na komandno dugme 28, odnosno Merge...

Posle toga dobicete dijalog kao na slici desno, gde je dovoljno da izaberete: da li dokument treba kreirati ili samo
Stampati, pa potvrdite na komandno dugme Merge.

Dobijeni dokument predstavlja proizvod (sli¢an aritmeti¢ckom proizvodu) dokumenta A i dokumenta B, pa se u
njemu izmene ne vrie, ve¢ je namenjen $tampanju, slanju preko fax uredaja, preko Internet servisa ili samo za pre-
gled. Greske u dokumentu C su samo rezultat gre$aka u A ili B, pa je bolje da ih "sasecete u korenu".

Ako ste glavni dokument - A i izvor podataka - B sacuvali (pod imenima npr. "Pismo" i "Klijenti") nema nikakvog
osnova da dokument C Cuvate, jer ga moZete kreirati preko prethodna dva kada god to poZelite. Desava se da doku-
ment C ima i stotinjak stranica, §to je jo§ jedan razlog viSe da ga ne Cuvate. Na poruku o tome da niste sacuvali krei-
rani dokument "Form Letters1", obavezno odgovorite sa No.
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PRIMENA CIRKULARA NA ADRESIRANJE KOVERATA

Za  slican  posao  —  Stampanje  koverata  sa  adresama, u  dijalogu  Mail  Marge
(u koraku 1.) izaberite Create» Envelopes, pa ¢ete dobiti predlog »

izaberite Change Document Type, pa (kada se pojavi) kliknite na komandno dugme Setup (da postavite parametre
oko veli¢ine koverte i orijentacije Stampanja).

Ako to ne uradite MS Word ée vas, posle definisanja izvora podataka (korak 2.) "presresti" porukom da je to
neophodno »

pa kada odredite veli¢inu koverte

(slika levo)

ubacite polja podataka u adresu,

kao kod kreiranja pisma

(slika desno)

Preostaje vam da jo§ upiSete povratnu adresu u gornjem levom uglu, eventualno podesite format u poljima adrese i

ubacite neko polje sa podatkom (npr. datum preko AutoText-a), pa da izviiite spajanje (mnoZenje?!) sa dokumentom
koji ste podesili kao izvor podataka i posaljete sve to na vag Stampac (izgleda da je on jedini koji ovde nesto radi).
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7] MS Word

Sabloni u MS Word-u

TEMPLATE — SABLON | PREDNOSTI KORISCENJA

Mnogi programi nude kompletne osnovne definicije (Template) projekta koji ¢e se u njima tek obradivati i naziva ih
Document Templates (sa ekstenzijom *.dot). Ako stil shvatamo kao kalup za tekst (pasus) onda bi $ablon bio kalup za
ceo dokument, ukljucujuéi tu sve stilove, strani¢ne oznake, ali neobavezno i tekst. Sablon, kreiran da posluzi kao
osnova neke publikacije (skripte, diplomskog rada, knjige itd.) ne sadrZi tekst (eventualno moZe imati Header i Foo-
ter), dok $ablon kreiran za popunjavanje obrazaca, slanje dopisa, fax poruka, itd., mora imati sav tekst i graficke ob-
jekte koji su dogovoreni prema poslovanju firme i ostavljen prostor za popunu onih podataka koji se razlikuju.

Mnogi korisnici MS Word-a se snalaze na taj nacin $to kreiraju poluprazne dokumente, pa im (posle popunjavanja)
daju drugo ime. Ovo je uvek rizi¢no, jer se moZe desiti da se ugrozi osnovni dokument, §to je kod korisé¢enja $ablona
tesko. Dokument, kreiran prema $ablonu, nema uticaj na $ablon, pa je tako $ablon uvek tu i da prenese sve svoje pa-
rametre (i sadr¥aj) na novi dokument.

Koristeéi §ablone za kreiranje dokumenata, smanjuje se verovatnoéa ponavljanja gre$aka (u podacima va?nim za ko-
risnika: sediste forme, ¥iro radun,...) kao i uniformnost>! dokumenata.

Ono §to je nas cilj u ovoj temi je da - ISPROBAMO kori$éenje postojeceg $ablona (npr. $ablon za kreiranje fax
poruke).

RAD PREMA POSTOJECIM SABLONIMA

Znali vi to ili ne, uvek koristite isti §ablon za dokumente u MS Word-u i to $§ablon Normal.dot. Ovaj $ablon je Word
(kao i ostale) doneo instalacijom, ali je zanimljivo da ga uvek kreira u slu€aju da ga vi obriete. Ako Zelite da kreira-
te novi dokument prema nekom od raspoloZivih §ablona — iskoristite File» New..., a zatim u dijalogu (kao na slici
desno) izaberite jedan od $ablona.

Kartice predstavljaju podfoldere u folderu "Microsoft Office\Templates\"*?, gde se nalaze i svi ostali $abloni za Mic-

rosoft Office programe. Ako na ovoj lokaciji kreirate®® folder imacete moguénost da u njemu dr¥ite sve 3ablone koje
ste kreirali i koje koristite u svakodnevnim poslovima u firmi. U polju Preview dobicete pogled na $ablon sa znatnim
umanjenjem.

Kada Zelite da kreirate novi dokument overite opciju Document (podrazumeva se), a za novi $ablon (prema postoje-
éem) overite na Template, pa na OK. Ako ste odabrali §ablon Professional Fax, (kao na gornjoj slici) dobi¢ete mogué-
nost da unesete ime vase firme, adresu, a zatim sve potrebno za popunjavanje jedne fax poruke. Posle zaglavlja i
polja za unos podataka o adresa primaoca i pogiljaoca, sledi prostor za unos teksta poruke.Polja za unos podataka su
osencena i sadrfe komentar o vrsti podatka, pa ¢e biti dovoljno da kliknete u neki i zapo&nete unos — komentar ée
se obrisati bez vasih dodatnih akcija.

Kada unesete sve potrebne podatke i tekst poruke sacuvajte ovaj dokument ili ga samo prosledite §tampacu ili mo-
demu za direktno slanje primaocu bez dodatnog kori$éenja Fax-maSine.

Slanje preko modema se ne razlikuje od slanja na §tampac s tim da ¢e vam MS Word traZiti in-
staliran MS WinFax ili drugi program koji je specijalizovan za ove poslove (najpopularniji je
WinFax Pro — trenutno u verziji 9.0). Ovi programi se lako koriste i predstavljaju puke posredni-
ke izmedu modema i svih ostalih programa iz kojih bi mogli da po3aljete dokument (u $tampa-
nom obliku) putem telefonske linije. Na ovaj nadin se $tedi jer nije potrebno dodatno $tampanje
i upotreba fax masine, veé se sve zavriava i pocinje uz racunar, pa se savetuje da ovakav pro-
gram nabavite ako 3aljete mnogo ovakvih i sli¢nih dopisa. Eventualni problem oko pecata i
potpisa moZe se rediti skeniranjem i ugradivanjem tog grafi¢kog objekta u sami $ablon.

napomene

31 v . c s Yo 2 [OPRR TR ¥ . . . . « s
Dokumente mdemo uniformisati tako §to ¢emo odrediti dizajn nageg memoranduma, logotipa, i sl., tako da svi dokumendeniai na3oj
firmi nose iste obavezne elemente (postavljene i dizajnirane) na istim mestima.

32 & . 1 . o . .
Sabloni izvan ovog foldera neée biti automatski degtni pa éete ih morati otvarati ko Windous Explore -a.

33 . o . . L, I o "
Savetuje se kreiranje SAMO jednog foldera pod imenom koje ée vas asocirati na poslove u firmi. Kompletan sadraj foldera u &komee
vase Sablone prekopirajte na disketu da biste imali njihovizeevnu u sliaju da "nesto sa réunarom krene nmpako".
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KREIRANJE NOVOG SABLONA®

Da biste kreirali $ablon prema svojim potrebama uradite sledece:
1. File» New, gde ¢ete odabrati onaj koji vam bar priblizno odgovara, ali overite opciju Template;

2. izvisite potrebne promene u $ablonu prekucavajuéi postojeci tekst i oblikuju¢i memorandum
vage fax poruke
(uvodenje sencenih delova za polja podataka je nesto sloZenije, pa ovde to neéemo obradiva-
ti®);

3. saluvajte ovaj $ablon pod karakteristi¢nim imenom (u vas§ folder za §ablone koji moZete sami
kreirati), pa ga zatim zatvorite;

4. pokusajte da ga pronadete (kreirajuéi novi dokument prema njemu) na File» New i to u kartici
kao i ime foldera koji ste kreirali (ovde ne zaboravite da potvrdite opciju Document);

5. novi dokument, kreiran prema vasem $ablonu, je pred vama, pa probajte rad u njemu.

Za korigovanje $ablona koiji ste kreirali (ne savetuje se korigovanje onih koje je MS Word sam "doneo") koristite uo-
bi¢ajen nacin otvaranja dokumenata s tim $to ¢ete na Files of type u dijalogu Open izabrati Document Templates i pot-
raZiti $ablon u svom folderu za $ablone. Sve promene u $ablonu ¢e se odraziti na njegovo buduce kori$éenje, pa vam
je uinteresu da poslove na njegovoj korekciji obavite na najbolji moguéi nacin.

§tampanje dokumenta

PREGLED | IZMENE SVO] STAVA DOKUMENTA

Na File» Properties dobicete svojstva dokumenta koji trenutno obradujete i to preko dijaloga kroz vise kartica (kao na
slikama)

gde ¢ete u kartici:

Summary (prva slika) mod¢i da aZurirate podatke kao $to su: naslov, tema, autor.. .,
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General (druga slika) dobiti samo na uvid informacije o samom fajlu: tip, lokacija, ime datum (kreiranja,
modifikovanja i poslednjeg pristupa) i njegovih atributa,

Statistics (trec¢a slika) dobiti detaljne podatke o datumima, korisnicima, kao i o broju objekata (strana, pa-
susa, linija, karaktera i karaktera uklju¢ujuéi i znak blanko).

POTREBA ZA STAMPACEM

Kako bi sve funkcionisalo kako treba MS Word-u nije neophodna instalacija §tampaca, ali drugi programi iz Micro-
soft Office i drugih paketa neée uopste modi da rade. Zbog Eega? Pa ako se programom priprema izgled teksta, grafi-
ke, prezentacije i sl. za Stampanje — desice se da program ne prepoznaje za kakav to Stampac treba da pripremi
Stampanje, pa ¢e "otkazati poslusnost" pri samom startu ili na pregled pre §tampe. Da biste ovo izbegli — instalirajte

bilo koji HP $tampa¢ preko: Start» Settings» Control Panel» Printers.®

NEOPHODNA PODESAVANJA | PREGLED PRE STAMPANJA

Veéi deo dokumenta ¢e i preko prikaza Page Layout izgledati kao u §tampanom obliku, ali u slu¢aju veéih i komplek-
snijih dokumenata (sa viSe razli¢itih oblika preloma) savetuje se obavezni pregled pre slanja na §tampanje. Ako pri-
premate dokument za §tampanje na nekom drugom mestu (npr. u firmi) trebalo bi da imate instaliran i aktiviran
(definisan kao "Default" $tampac), jer biste u suprotnom mogli imati velike "glavobolje" zbog razlika koje dobijete na
drugom $tampacu.

Pored toga vaZno je usaglasiti i definisanu veli¢inu papira u dokumentu i one sa kojom va§ $tampac radi (bilo da
Stampad imate prikljucen ili ne).

Izgled vaSeg dokumenta u $tampanom obliku dobicéete aktiviranjem Print Preview prikaza na File» Print Preview ili
klikom na komandno dugme &u Standard paleti.

MoGUCI PROBLEMI

YU slova na nekim $§tampacima — Nikad kraja problemima sa YU slovima - na nekim §tampacima se ona uporno
ne pojavljuju, ¢ak ni kada koristite Windows za Centralnu i Isto¢nu Evropu. U Windows-u je sve postavljeno prema
kodnoj strani CP1250 (SI), u MS Word-u takode, a na ekranu se, ¢ak i u Print Priview modu, vide nasa slova, dok
Stampa ispisuje samo veliko S. Umesto ostalih YU slova se pojavljuje kvadrati¢. Na Hewlett-Packard-ovim laser-
skim §tampacima tih problema uglavnom nema, verovatno zato $to se kod pode$avanja parametara §tampaca moze
izabrati opcija Print True Type as Graphics, ali ni oni nisu imuni na probleme sa ne prepoznavanjem ¢irili¢nih slova.

Generalno podesavanje MS Word-a

OPTIONS
Preko Tools» Options dobiéete da podesite (ili pokvarite) mnogo toga u vasem MS Word-u, pa krenimo ispocetka
kroz kartice ovog dijaloga i pomenimo najvaznije opcije podeSavanja (uklju¢ivanja—isklju¢ivanja).
VIEW
U ovoj kartici (kao $to i njeno ime govori) podesavaju se opcije o vidljivosti u dokumentu:

Drawing — grafickih objekata v

Text boundaries — granica i margina teksta
Animated text — animiranih formata teksta v
Screen Tips — kratkih poruka u obliku oblac¢iéa v
Highlight — signiranih delova teksta v

Nonprinting characters — karaktera koji se ne $tampaju,
gde se savetuje samo Hidden text v

Window — delovi radnog okruZenja v v v v
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GENERAL

Ovde se savetuju podesavanja:

Update automatics... —za automatsko osveZavanje objekata povezanih preko Link to File prilikom otvaranje
dokumenta v

Recently used file list —prikaz liste (1 do 9) prethodno otvaranih fajlova v

Macro virus protection — upozoravanje kada u dokumentu (koji otvarate) postoji Macro®@ (iskljucite)

Measurements units —jedinica dufine mernog sistema koji koristite
(podesite na Centimeters)

EDIT

Parametri u ovoj kartici se odnose na opcije u vezi aZuriranja (editovanja, kucanja):
Typirng replaces selection za prekucavanje preko selektovanog teksta v
Drag-and-drop text editing kori§¢enje Drag & Drop metode v
When selecting, automatically select entire word
automatska selektovanje dopuna selekcije
na cele rediv
Use smart cut and paste napredno Cut i Paste sa kontrolom blanko prostora izmedu re&i
Tabks and backspace set left indent
pomeranje levog uvladenja prilikom aZuriranja preko <Tab> i <Backspace> taste-
ra na pocetku pasusa v

PRINT
Parametri za podeavanje Stampanja:
Update links za automatsko osveZavanje objekata povezanih preko Link to File prilikom slanja na
Stampu v
Allow A4/Letter paper resizing promena veli¢ine papira u slu¢aju da §tampac da signal o takvoj greici (bez poruke) v
Background printing rad na obradi dokumenta dok se odvija §tampanje v
Drawing objects uklju¢ivanje grafickih objekata u §tampu v

Ne ukljucujte za Stampu Hidden tekst, jer je njegova svrha kori¢enja da se pri aZuriranju doku-
menta vidi, a u Stampanom obliku da bude sakriven. Kada Zelite sve osobine dokumenta ta ods-
tampate uz sam dokument uklju¢ite Document properties.

—
.
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SAVE

U ovoj kartici su smestene sve opcije oko ¢uvanja dokumenata:

Alaways create backup copy kreiranje kopije pri svakom snimanju
Embed Trie Tyte fonts pridruZivanje TT fontova uz dokument

Save AutoRecover info every automatsko periodi¢no ¢uvanje dokumenta

(postavite na period od oko 30 minuta)

PridruZivanje fontova se koristi pri prenosu dokumenta na
drugi rac¢unar ili slanju i kada niste sigurni da na drugoj lo-
kaciji postoje fontovi koje ste u njemu koristili. Ovim se
dokument znatno povecava ako ste koristili mnogo fonto-
va.

SPELLING & GRAMMAR®

U ovoj kartici se pode$avaju parametri oko ispitivanja i ispravljanja pravopisnih i gramati¢kih gresaka.

FILE LOCATIONS

Podesavanje parametara (foldera) u kojima se:
Documents najéesée Cuvaju nalaze dokumenti
Clipart pictures mnalazi izbor instaliranih grafi¢ckih dodataka
User Templates nalaze korisnicki $abloni

Startup nalaze datoteke za automatsko otvaranje

Word & Excel - Kurs za poslovne sekretare
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[8] MS Excel

Uvod u MS Excel

PRIMENA

Ve niz godina, MS Excel predstavlja jedan od najéesée koriséenih programa za tabelarne proracune, a sa efikasnom
primenom u matematici, statistici, knjigovodstvu, kancelarijskim poslovima i sli¢nim delatnostima. Od svoje prve
verzije Excel se namece svojom jednostavnoséu i korisni¢kom orljentacijom, a §to éete uociti samo ako ste veé radili
u nekom programu sli¢ne namene. VeStom navigacijom, kori§¢enjem ugradenih funkcije i naprednih moguénosti
kojima Excel raspolaZe, veoma je lako voditi poslovanje i efektno prezentirati postignute rezultate firme.

Uhodano je pravilo da se, za organizovanje svojih podataka, korisnici upucuju uvek u programe za obradu tabela —
zbog Cega? Tekst unet u nekom tekst procesoru moZe da sadrZi hijerarhiju, ali je za iskori§¢enje podataka i veza iz-
medu njih neophodna i njihova organizacija. Kada se neka grupa podataka smesti u tabelu tek tada se njena organi-
zacija moZe uociti, a podaci iskoristiti za obradu i u drugim programima gde se traZi veéi ili kompleksniji stepen
organizacione strukture (relacione baze podataka).

Dakle, ako ve¢ kreirate tabelu — iskoristite moguénosti i komfor MS Excel-a i bicete prijatno iznenadeni njegovim
moguénostima.

RADNO OKRUiEN]E | PALETE ALATA

Elemente radnog okruZenja MS Excel-a su skoro isti kao kod MS Word-a. Sve razlike koje budete uoéili svode se na
dodatke za formatizovanje podataka i precice ka popularnim alatima.

Menu Bar, je paleta menija i upravljanje njom je isto kao i u svim drugim programima. Njeno pomeranje je moguce
ali se savetuje da ona bude smestena u vth MS Excel prozora (kao na slici)

Standard Toolbar — je paleta sa mnogo alata koje se primenjuju na isti na¢in i u drugim programima, ali i niz specifi-
¢nih alata, kao npr:

e AutoSum — automatsko sumiranje, o Paste Function — pozivanje alata za primenu funkcije,

e Sortiranje — opadajuce i rastuce, o Chart Wizard — za kreiranje grafikona.

o Map® — ubacivanje geopoliti¢ke karte. o Drawing® — otvaranje palete za rad sa grafi¢kim elemen-
tima...
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Formatting Toolbar — sadr?i mnogo alata za formatiranje, kao npr za Font, Font Size, Bold, Italic, Underline, horizon-
talno poravnanje sadr?aja u ¢éeliji, centralno spajanje éelija, primenu valutnog, procentualnog i decimalnog formata,
povedéanje i smanjenje broja decimalnih mesta,... (prva slika)
Otvaranjem nekih alata iz ove palete otvaraju se detaljne palete za specijalne namene, kao npr:
Borders — za iscrtavanje granica Celija,
Font Color — zadavanje boje teksta,
Fil Color —zadavanje boje popunjavanja u ¢éeliji,
kao na slikama desno.
Chart — paleta neophodnih alata za upravljanje i dizajniranje dijagrama, §to ¢e vam zatrebati u kasnijem
radu, kada budemo obradivali kreiranje dijagrama.

CusToMIZED

Kada se nametne potreba za uklju¢ivanjem ili isklju¢ivanjem vidljivosti neke od paleta treba:

1. kliknuti desnim tasterom misa u bilo koje komandno dugme u bilo kojoj od vidljivih paleta (&i-
me se dobija meni kao na slici desno);

2. udobijenom meniju su vidljive palete Stiklirane, pa se klikom na nju dobija suprotan status (vid-
ljiva ili ne)

3. ako paletu treba pomeriti, u¢inite to preko njenog zaglavlja (kao za svaki prozor) ili preko dve
linije u njenom levom kraju (ili gornjem kada je vertikalno postavljena)

RADNI LISTOVI — ELEMENTI RADNE KNJIGE

List papira u MS Word-u nije pravo poredenje sa radnim listom u MS Excel-u, jer radni list u MS Excel-u:
1. ima visok stepen organizacije i strukturnog formatizovanja podataka
2. omoguéava primenu kompleksnih matemati¢kih veza

3. moZe se podeliti u vise listova za §tampanje

Tako radni listi (Sheet) vise li¢i na jedan dokument u Word-u, pa se namecée i potreba za pojmom RADNA KNJIGA,

koja u sebi moze sadr¥ati vise (do 255) radnih listiva, ali i veze na vige drugih radnih knjiga@. Tako se organizacija
u radnoj knjizi moZe podi¢i na znatno visi nivo od one koju poznaje MS Word ili neki drugi program za obradu teksta
i tabela, ali i dovoljno daleko da bi se poredila sa bazom podataka.

Pored toga, MS Excel radna knjiga, pruzajuéi moguénost definisanja formata podataka (osim kada se vi toga odrekne-
te), postiZe znatno smanjenje u veli¢ini fajlova. Ovo postiZu svi programi ta tabelarne proracune, pa ne predstavlja
revolucionarnu inovaciju.

Radom u MS Excel pokusajte da prednost date podacima (njihovoj ta¢nosti, formatu prikaza i matematickih veza), a
§to manje formatizovanju u smislu dizajna. Ako se ve¢ traZi reSenje dizajna, ono se uvek radi na samom kraju obrade
podataka.

Radnu knjigu ¢ine radni listovi u njoj, pa bez radnog lista radna knjiga ne moZe postojati. Radna knjiga moZe imati

do 255 radnih listova.

ELEMENTI | ORGANIZACI JA RADNOG LISTA

Elemente radnog lista &ine kolone i redovi, a koje opet sadr¥e éelije. Celije su uredene u strogom®* poretku vertikal-
no ili horizontalno bez dileme o tome kom redu i koloni pripadaju. Ovim principom je omoguéeno lako uvodenje
matematickog modela, kao i korekcije u njemu. Radni list ima 65536 redova i 256 kolona, §to je isuvise veliki pros-
tor da bi razmisljali o ograni¢enjima.

napomene
34 4 1 N . . e . s
Celije koje "isk@e" iz ove organizacije ne mogu se uzeti keo elementi matemékig modela, veé samo kao elementi dipaa.

(ovo je slwaj prosirenja jedne éelije preko vise postojeéih).

Word & Excel - Kurs za poslovne sekretare 47



www.InterBEST. co.yu

Navigacija, selektovanje i azuriranje

NAVIGACIONI REZIM

Ovo je uobicajen reZim rada kojim je omoguéeno kretanje i uvid u sadr?aj radnih listova. U navigacionom reZimu
rada pointer mia je u obliku znaka . Selektovanje delova radnog lista se vr3i uvek u ovom rezimu. Kretanje je omo-
guéeno preko tastature i mifem, ne razlikuje se od navigacije u MS Word-u, pa éemo ovde navesti ono po ¢emu se

MS Excel razlikuje u navigaciji od MS Word-a:
1. ¢éelijaje osnovni element, pa je najmanji korak kretanja prelazak iz jedne u drugu éeliji
(u edit reZimu se moZe kretati i kroz sadrzaj same éelije)
2. kretanje i pozicioniranje na udaljenu poziciju se brze postiZe preko vertikalnog i horizontalnog

kliza¢a

(ScrollBar-a)

3. prelazak u drugi radni list treba da zapo¢ne klikom na karticu odnosnog radnog lista.

SELEKTOVANJE ELEMENATA RADNOG LISTA

Selektovanje kolone

klikom (ili desnim klikom) u zaglavlje kolona (slovna oznaka).

Selektovanje vise
kolona

posle selektovanja jedne kolone, uz drzanje tastera <Shift>, treba kliknuti na
poslednju kolonu koju obuhvatamo selekcijom (univerzalni nacin selekcije).

Selektovanje reda

kao i viSe redova sprovodi se analogno selektovanju kolona.

Jedna éelija u
radnom listu

mora uvek biti selektovana, odnosno éelija na koju ste se pozicionirali smatra
se i selektovanom.

Selektovanje opsega
(grupe) éelija

pozicioniranjem u prvu Celiju u zamisljenoj selekciji, pa uz drfanje tastera
<Shift>, klikom na poslednju éeliju.

Pojedina¢no
selektovanje kolona,
redova ili éelija

uz drzanje tastera <Ctrl> treba klikom odabrati pojedina¢no vise objekata.
Ovaj nadin selektovanja se koristi uglavnom u cilju dizajniranja, jer mali broj
funkcija se moZe primeniti na ovako selektovane objekte.

Selektovanje radnih
listova

analogno prethodnim nacinima (funkcije nad grupom® radnih listova ovde
neée biti obradivane).

EDIT REZIM — AZURIRANJE SADRZAJA CELIJE

Kada Zelimo promenu vrednosti u tekucoj ¢eliji moramo uéi u edit reZim na jedan od slede¢ih nacina:
e ukucavanjem preko tastature — naj¢e$ci nacin,
(automatski se prelazi iz navigacionog u edit reZim i unosi nova vrednost, a prethodna vrednost brise)
o pritiskom na taster <F2>
(dobar nacin kada treba popraviti vrednost u €eliji i uobi¢ajen je i u drugim programima);
e dvostrukim klikom u éeliju ili
e klikom u Formula Bar (preporucuje se samo iskusnijima, jer je osetljiv).

Sadrzaj Celije uvek je ispisan u Formula Bar-u. Prikaz u éeliji moZe se lako nacin promeniti kori§éenjem formatiranja,
ali je vrednost u njoj (bez primene formata) uvek predstavljena u Formula Bar-u.
Dok je korisnik u edit reZimu (ekranski kursor trepée u éeliji) MS Excel ne vrsi nikakve proralune, pa ako Zelite da
vidite uticaj unete vrednosti na ostatak vaeg matemati¢kog modela morate izaéi iz njega na jedan od nacina:

o prelaskom u drugu éeliju: klikom miSem, tasterom <Tab> ili <Enter>,

e zadrzavajudi se na istoj ¢eliji <Shift>+ <Enter>,

o otkazujuéi unetu vrednost u éeliju — taster <Esc>.
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PRIMENA DRAG & DROP U MS EXCEL-U

Jedina razlika izmedu Drag & Drop u MS Word i MS Excel je to $to: kada Zelite Drag & Drop u MS Excel-u morate
pointerom misa da ukaZete na granicu selekcije, pa kada se mi§ pretvori u strelicu — odvucete selektovano na drugu
lokaciju.

Ako odvlagenje obavite desnim tasterom misa dobicete i PopUp meni iz kojeg moZete odabrati jednu od akcija na
raspolaganju.

Prednost ovakvog nacina nad Cut & Paste je to $to se na isti nadin primenjuju nad svim objektima i §to omogucuju
lako odrZavanje postojeceg matematickog modela.

Umetanje i brisanje elemenata radnog lista

UMETANJE KOLONA | REDOVA

Princip umetanja (ubacivanja) kolona ili*® redova zasnovan je na principu: koliko selektovanih — toliko i ubacenih,
obavlja se najlakse na sledeéi na&in:

1. desnim klikom selektujte kolonu (ili red)

2. udobijenom meniju izaberite stavku Insert

Ako selektujete vise kolona (ili redova), desni klik primenite tek posle selektovanja.

UMETANIJE | BRISANJE CELIJA

Kada se umece (insertuje) red, kolona ili éelija, koristi se meni linija, komanda Insert» Cells i dobija se slede¢i dija-
log:

Shift Cells Right | umece éeliju tako $to tekuéu ¢eliju pomera udesno

Shift Cells Down | umedée éeliju tako §to tekuéu éeliju pomera nadole

Entire Row | umeée novi red tako $to red u kome je kursor pomera nadole

Entire Column | umeée novu kolonu tako §to kolonu u kojoj je kursor pomera
udesno
Kad se brige red, kolona ili éelija, koristi se komanda iz meni linije Edit» Delete, nakon koje se dobija slede¢i dijalog:

Shift Cells Left | brige éeliju tako §to éelije desno od aktivne pomera ulevo

Shift Cells Up | briSe ¢eliju tako $to donje ¢elije pomera nagore

Entire Row | brise tekuéi red

Entire Column | brige teku¢u kolonu

PRIMER ZA VEZBU

Unesite tabele kao na slici bez formatizovanja i sumiranja.

napomene

35 .. y L .
U isto vieme se ne moze ubaciti i kolona i red.
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[9] MS Excel

Format celije

ZASTO FORMATIZOVATI

NajvaZniji postupak u upravljanju podacima je njihovo formatizovanje. Pored toga §to ¢e vam omoguéiti da podatke
vidite onako kako vam najvise odgovara, ustedecete mnogo vremena na unosu, jer nije potrebno unositi one delove
koji se mogu urediti formatom podatka (npr. oznaka valute, decimalni deo broja,...).

Iako se do mnogih alata za formatizovanje moze dod¢i i preko palete Formatting, dijalog Format Cells je pravo mesto i
omogucuje kompleksnije oblike formatizovanja. Kada preko njega Zelite da formatizujete selektovani opseg ili jednu
¢eliju otvorite ga preko Format » Cells ili tasterskom kombinacijom <Ctrl>+1, pa ¢ete dobiti (kao na slici desno)
kompleksan dijalog sa 6 kartica).

NUMBER KARTICA
Owa kartica omogucava dodelu jednog od ugradenih formatai to:

General | ovo znaci da prepustate MS Excel-u da na osnovu unete vrednosti u éeliji poku$a da prepozna
njen format i automatski je formatizuje. Kada MS Excel prepozna format podatka u éeliji njen
sadrZaj bi¢e poravnat po desnoj strani ¢elije, dok se u suprotnom poravnava po levoj. Svi for-
mati koje ste definisali u Regionall Settings® bice ovde prepoznati upravo na takav nadin.

Number | je najces¢i format i koristi se za ispis formata brojeva. Ovde se definiSe broj decimalnih mesta,
prikaz separatora grupa cifara®® (ili ne) i jedan od predlozenih formata prikaza negativnih bro-
jeva.

Currency | predstavlja format valute, gde treba definisati broj decimala i simbol valute (npr. "din"), dok je
ostalo kao za format Number.
Accounting | je format za prikaz stanja konta — sli¢an valutnom s tim $to ne poznaje negativnu vrednost, a
umesto nulte prikazuje znak "-".
Date i Time | za format datuma i vremena (preporucuje se datum: dd.mm.yyyy, a vieme na HH:mm)
Percentage | procentualni format
Fraction | format za prikaz razlomaka
Scientific | format za ispis vrlo velikih ili vrlo malih vrednosti oblika npr.: 13,3564E+11, koji koristi
princip znacajnih cifara®” da bi prikazao $to ta¢niju vrednost
Text | ovaj format se dodeljuje onim podacima koji ne mogu da se prepoznaju pod bilo kojim drugim
(ovo je vestacki format i treba ga najmanje koristiti, jer ne obezbeduje u§tedu u smestanju po-
dataka)

Special | ovim formatom se obezbeduje formatizovanje posebnih vrsta podataka kao $to su: poStanski

broj, broj telefona, mati¢ni broj i sl.
® Custom | omogucéava detaljnije oblikovanje svih pomenutih, ali i dodatne. Svi formati su ustvari samo
prikaz MS Excel-a za korisnika, a svi oni se izvode preko ove definicije formata.

napomene

3 Separator grupa je znak kojim se razdvajaju grupe u celobrojnom delu vrednosti, a dafeino je deljenje na hiljade (kod nas je taj simbod+
¢ka, dok decimalni simbol treba gdesiti na zapetu).

37 ” y . G VT . ; . - . ;
MS Excel vr$i proratune na najvise 15 zndajnih cifara (uklj@ujuéi i decimalni simbol), a za poveéanu &aost treba primeniti neki od uob

Cajenih algoritama namenjenih za to u VB@.
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ALIGNMENT KARTICA
U ovoj kartici se pode$ava horizontalna i vertikalna pozicija sadrZaja Celije, orijentacija, kao i specijalni kontrolisa-
nja teksta:

e Wrap text — moguénost vertikalnog $irenja celije u skladu sa unetim tekstom u vise redova,

o Shrink to fit — skupiti tekst ako ne moZe da stane u ¢eliju,

e Merge cells — spajanje (stapanje, ujedinjenje) vise éelija u jednu.

FONT KARTICA

Owva kartica sadrZi sve standardne elemente formatizovanja teksta: Font, Font Style, Font Syze, Underline, Color, ...

BORDER KARTICA

Ovo je nesto kompleksniji dijalog u kome se zadaju oblici iscrtavanja granica ¢elija. Pre definisanja bilo kojih bor-
der-a potrebno je da izaberete Style (vrstu linije) i Color (njenu boju). Posle toga sve se lako zadaje, kako sa koman-
dnih dugmadi tako i na primer u centru (klikom miSem)

PROTECTION KARTICA

U ovoj kartici moguée je deklarisanje nekog oblika zastite Celije i to:
Locked —zakljucana ¢elija (njen sadrzaj se ne moZe se modifikovati),
Hidden - sadrZajcelije se sakriva (ne vidi se).
Zastita Celije Ce biti uzeta u obzir kada se zastiti i radni list (poslednja tema u ovim skriptima).

Format celije zasnovan na vrednosti®

GENERAL®D

Ako format ¢elije definiSete pod tipom General, MS Excel ¢e pokusati da automatski odredi i dodeli format éelije po-
sle unete vrednosti. Kada koristite ovu moguénost imajte u vidu da podatke morate uneti bez greske, jer ée npr.u
slu¢aju da unesete "1.98" prepoznati format datuma i formatizovati kao "Jan.98".

Iako ovo &esto predstavljati prednost (u slu¢aju kopiranja podataka iz drugih programa), ipak je bolje koristiti jedan
od predloZenih formata za podatke iz kartice Number dijaloga Format Cells.

USLOVNO FORMATIZOVAN] E (CONDITIONAL FORMATTING)®

Kada je potrebno naglasiti rezultat neke formule ili vrednosti unete u éeliju, za éeliju se moZe definisati i uslovni
format preko Format» Conditional Formatting. Preko dijaloga (kao na slici desno) mogu se zadati najvise 3 vezana us-
lovai to npr.
1. zavrednost u éeliji manju od 30, prvi format
(ispis vrednosti u €eliji crvenom bojom)
2. zavrednost izmedu 30 i 60, drugi format
(podvuéen tekst — Underline)
3. zavrednost veéu od 60, treéi format
(precrtan tekst — Strikethrough)

Ovde je omoguéeno formatizovanje u smislu izgleda i to: stil i boja fonta, podvladenje, precrtavanje, sencenje i boja
celije, oivicavanje (Borders) celija. Uslovni format se moZe definisati i preko Custom kategorije u dijalogu Format
Cells.

Formatiranje tabele

TABELA — OPSEG CELIJA

Deo radnog lista u kome su éelije vezane matemati¢kim modelom i vidno oznadene kao jedinstvena celina — naziva
se tabelom. Da bi se odvojila od ostalih tabela u radnom listu, oko tabele se obi¢no ostavlja prazan prostor (ograni-
Cena je praznim Eelijama). Primena mnogih operacija nad tabelom zahteva da se zaglavlje u nju obavezno unese, i
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po moguénosti razlikuje po formatu od ostatka tabele. Tabelu uvek treba tako osmisliti da se podaci u nju dopunjuju
unosom novih redova.

AUTOFORMAT — ALAT VREDAN PAZNJE

Kao $to smo isprobali u MS Word-u, AutoFormat za tabele vaZi i u MS Excel-u preko Format» AutoFormat... Ovde je
taj alat jo§ potrebniji, jer pored formata u pogledu dizajna dozvoljava format i u pogledu tipa podatka u éelijama.

Da biste primenili jedan od predloZenih AutoFormat-a nije potrebno da selektujete, veé samo da se pozicionirate u
jednu ¢eliju tabele u okviru radnog lista, pa ée MS Excel sam prepoznati granice, zaglavlja i sumiranja, ¢ak i kada
imate viSe odvojenih tabela u tekué¢em radnom listu.

Br#i i napredniji rad u MS Excel-u zahteva obavezno kori§¢enje AutoFormat-a, a potom korekcije formata u tabeli
(ako je to potrebno).

PRIMERI ZA VEZBU

U prvom primeru (slika desno) treba primeniti formatizovanje podataka:
kolona Bi C — text,

kolona D — "dd.mm.yyyy",

kolona E — ceo broj,

kolona F — Currency.

U drugom primeru (slika desno) treba primeniti neki od AutoFormata, a potom preko AutoSum®-a izvriiti sumira-
nje po redovima i kolonama

napomene

38 7a automatsko sumiranje éelija po redovima i/ili kolonama selektujte éelije u koje sunebarda bude upisana, pa kliknite u ikocnicu Amt
Sum na Standard paleti.
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[10] MS Excel

Adresiranje u MS Excel-u

ADRESA — REFERENCA

Svaka ¢elijau MS Excel-u ima svoju adresu, a mogu se koristiti slededi tipovi referenci:

relativne reference A4, CG45
apsolutne reference $A$4, $CG$45
kombinovane reference $A4ili A$4

Apsolutne (i kombinovane) reference razlikuju se od relativnih po znaku "$" ispred oznake reda i/ili kolone. Ovaj
znak moZemo protumaciti kao “zaklju¢ana adresa”, pa ako se nalazi ispred oznake kolone — zaklju¢ava kolonu, a ako
se nalazi ispred oznake reda (u referenci) — zakljucava red.

SIMPLEX

Pojam funkcije i operatora u Excel-u

FUNKCIJA ILI FORMULA

Funkciju i formulu treba da razlikujete po tome $to funkcija vraca vrednost u zavisnosti od prosledenog argumenta,
dok formula moZe biti prost oblik primene neke aritmeti¢ke operacije, pa sve do sloZenog oblika nekoliko vezanih
funkcija.

Funkcije su: COS(x), SIN(x),..., a formule sunpr: X+Y; 5*COS(x),...

OPERATORI | NJIHOVI P RIORITETI

Operator obavlja aritmeti¢ke operacije, logi¢ka i relaciona testiranja. Ovi operatori omogu¢avaju kreiranje formula i
imaju svoje prioritete izvr$avanja, pa ¢e tim redom biti i opisani:

Tip| Simbol Opis Prioritet
Aritmeticki A stepenovanje 1
- negativni predznak 2
* mnoZzenje 3
/ deljenje 3
+ sabiranje 4
- oduzimanje 4
Relacioni = jednako (ili dodela) 6
> vece od 7
< manje od 7
<= manije ili jednako 7
>= vece ili jednako 7
<> razliCito 7
String operatori & nadovezivanje stringova 5

Logicke operatore AND, OR, NOT MS Excel je dao na raspolaganje u obliku funkcija, ali dodao i svoje specijalne:
FALSE i TRUE funkcije.
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PASTE FUNCTION

Kada je potrebno primeniti neku standardnu funkciju MS Excel-a, najbolje je pokrenuti Paste Function sa Standard
palete, ¢ime ¢ete dobiti moguénost da (iz leve liste u dijalogu kao na slici) izaberete grupu funkcija i funkciju iz date
grupe (prikazanu u desnoj listi). Pored toga, u donjem delu dijaloga, tekuéa funkcija ¢e biti ukratko opisana.

Funkcija se bira dvostrukim klikom migem ili preko tastera OK, posle ¢ega se ulazi u dijalog (kao na sledeéoj slici),
gde se u nekoliko tekst okvira zadaju argumenti funkcije (broj parametara zavisi od izabrane funkcije).

Argument Cete zadati tako $to se pozicionirate u mesto za argument, pa na radnom listu kliknete u éelijuili selektu-
jete opseg Celija (3to zavisi od funkcije).

Prvih nekoliko puta kori§éenja ovog dijaloga budite vrlo obazrivi pri definisanju argumenata i prelasku iz jednog u

drugo polje za argument. Najbolje je da za selektovanje argumenata iz radnog lista koristite kombinacije miSem i tas-
terom <Shift>, dok je za prelazak iz jednog u drugo polje za argument najlak3e koristiti <Tab>.

Funkcija uslovne dodele (IF)

SINTAKSA | PRIMENA
Funkcija IF se primenjuje u situaciji kada ¢eliji treba dodeliti jednu vrednost pod datim uslovom, a neku drugu vred-
nost ako taj uslov ne bude ispunjen u obliku:
=|F(LogickiTest; VrednostZaTacno; VrednostZaNetacno)
gde je:
LogickiTest | test koji moZe dobiti vrednost TRUE (ta¢no) ili FALSE (netac-

no), a kome se obi¢no koriste relacioni operatori: >, <, >=,
<=,<>

VrednostZaTagno | je ona vrednost (podatak iz Celije ili bilo koji drugi na raspola-
ganju) koja se ¢eliji dodeljuje u slu€aju da je traZeni uslov zado-
voljen — talan;

VrednostZaNetacno | je ona vrednost koja se ¢eliji dodeljuje u slu¢aju da je traZeni us-
lov nije zadovoljen (ovaj argument nije obavezan)

PRIMER PROSTOG OBLIKA IF FUNKCIJE
U ovom primeru ¢emo resiti pitanje (odgovoriti na pitanje) DA LI JE STUDENT POLOZIO ISPIT?, pa ¢emo: u

slu¢aju da je osvojio vise od 50 bodova — odgovarajuéoj éeliji (u koloni E) dodeliti vrednost "Da", a u suprotnom

HNeH
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PRIMER POTPUNOG OBLI KA IF FUNKCIJE

Na ovom primeru ¢emo videti kako se moZe uticati na formiranje cene artikla prema stanju tog artikla na zalihama
(magacinu).

Ukoliko stanje bude ispod definisane granice (50) cenu treba povecati za 12,57%, dok je u suprotnom treba smanyjiti
za 21,20%.

PRIMER SLOZENOG OBLIKA IF FUNKCIJED

U ovom primeru ¢emo videti kako se, primenom dvostruke IF funkcije ili primenom pomoéne Eelije, moZe dobiti
komentar o pripadnosti neke vrednosti zadanom opsegu. Ovde najpre treba uneti pomoénu formulu u kolonu D, pa
tek potom glavnu u koloni C, posle ¢ega kolonu D moZete sakriti (desni klik miSem u zaglavlje kolone pa klik na
stavku Hide).

PredloZene formule u éelijama kolona C i D su uradene u nesto sloZenijem obliku da bi se obezbedila fleksibilnost
modela, ali ih vi moZete za poetak uneti i u prostijem obliku, kao npr:

ucelijiD3 =IF(B3>56;"vedi od 56";"izmedu 301 56") i
uéeliji C3 = IF(B3<30;"manji od 30";D3)

Posto uotite sve vrednosti koje bi u primeru mogle da budu promenljive, pokusajte da formule modifikujete pre-ma
primeru na slici.

U ¢éeliji G3 pokusajte sami da unesete funkciju kojom ¢e se ispitivati da li je ispunjen uslov da je donja granica (E3)
manja od gornje granice (F3) (re$enje je sli¢no prvom primeru za IF funkciju).

Za primenu fleksibilnijeg matemati¢kog modela potrebno je maksimalno izbegavati zada-

vanje konstantnih vrednosti u argumentima funkcija. Tako u prethodna dva primera nesto
kompleksnije kreirati funkcije, ali je znatno olak$ano testiranje, jer se promenom vrednos-

ti u éelijama moZe uticati na ceo model.
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Imena u Excel-u

OSNOVE | PREDNOSTI PR IMENE

Imena sluZe za laksi i jednostavniji rad sa grupama éelija. U kompleksnim formulama jako je tesko voditi ratuna o
sadrZaju tabela, formula i adresama ukoliko se operacije obavljaju koriséenjem referenci (kao npr. "=sum((b44/al3)-
g15+4.44)"). Uvodenjem imena, svaka Celija (ili blok éelija) dobija jedinstveno ime, tako da je njeno pronalaZenje i
kori§éenje znatno lakse.

PRAVILA | NACIN KORIS CENJA

MS Excel razlikuje dve vrste imena: globalna i lokalna. Globalna imena se odnose na grupe ¢elija u nekom radnom
listu ali su vidljiva u bilo kom radnom listu iste radne sveske. Nalaze se u spisku imena i mogu se koristiti i ukazivati
na te Celije iz bilo kog drugog radnog lista.

Lokalna imena se odnose samo na odredeni radni list i ne mogu se koristiti u drugim radnim listovima.

Ime se najlakse deklarisu preko Name Box — polja za ime, dok se najbolje kontrolise preko dijaloga Define Name (koji
se otvara preko Insert» Name» Define...), gde se imena mogu ispravljati, brisati, menjati njihovi opsezi,...
Opis postupka dodele imena:

1. selektujte opseg Celija koje Zelite imenovati;

2. otvorite dijalog Define Name;

3. unesite ime prvo tekstualno polje;

4. kliknite na taster Add i potvrdite na OK.

Ime treba da zapo&ne slovnim znakom, sadr?i do 40 slovno (A-Z) brojevnih (0-9) znakova ukljucujuéi tacku i znak
nn

Sledeéa tabela prikazuje regularna i neregularna imena

REGULARNA IMENA NEREGULARNA IMENA
KursnaLista.Maj 95.Promet (pocinje brojem)
Zarada 1998 Bruto Dobit (sadr?i razmak)
PojedinacnaCena A20 (kao referenca Celije)

Pitanje posebnih YU slova, kao §to su SPCCZsde¢# ili pak ¢irili¢nih LY FXIbHb3, moze se posmatrati u odno-

su na oblik i nivo kori§¢enja, kao i planiranu buduénost radne knjige:

1. kada korisnik ima korektno instaliranu viSejezi¢nu podriku 'Multilanguage Support' ® i nema nikakvih
problema u kori§¢enju iste — savetuje se da, radi boljeg snalaZenja, koristi i ova slova u imenima radne
knjige MS Excel-a;

2. kada radna knjiga treba da bude distribuirana drugim korisnicima na razli¢itim Windows platformama

(ako viSejezi¢na podrska nije izvesna) onda ove znake treba maksimalno izbegavati;

3. ako se u radnu knjigu unose podaci koji bi kasnije mogli biti iskori§¢eni za razvoj planirane baze podata-
ka (npr. u MS Access-u) — treba izbe¢i imenovanje ¢irili¢nim slovima, a podaci treba da budu obavezno
unoSeni u jednom od kodnih rasporeda podrzanih od Windows-a (srpsko latini¢no ili srpsko ¢irili¢no pi-
smo).

Primena imenovanja je data u primeru za SUMIE

56 MS Excel - Imena u Excel-u



R S. Mikanovié

[11] MS Excel

Sumiranja

PROSTO SUMIRANJE (SUM)

Sumiranje je funkcija koja se naj¢esce koristi u tabelama. Ako je opseg ¢elija za sabiranje kompaktan (nepodeljen)
najbolje je iskoristiti AutoSum, a u suprotnom pozvati funkciju SUM preko Paste Function. Ovde se moZe odrediti do
30 argumenata koje treba sabrati, a oni mogu biti zasebne éelije ili blokovi ¢éelija.

U sledeé¢em primeru, prva dva sumiranja su obavljena nad blokovima, dok je treée primenjeno nad pojedinacnim ée-
lijama.
UsSLOVNO SUMIRANJE (SUMIF)
SUMIF je funkcija uslovnog sumiranja sa slede¢om sintaksom:
=SUMIF(Oblastlspitivanja; Kriterijum; Oblast Sabiranja)
gde je:
Oblastlspitivanja | je jedna ili opseg ¢elija nad kojima se ispituje dati uslov

Kriterijum | je uslov koji se ispituje nad éelijama oblasti ispitivanja

OblastSabiranja | je odgovarajudi opseg ¢elija koje se sabiraju tek kada, njima od-
govarajuéi element iz oblasti ispitivanja, zadovolji dati uslov

U narednom primeru ¢emo najpre deklarisati imena TRZISTE (opseg ¢elija B3:B12), PROIZVOD (opseg ¢elija
C3:C12) i KOLICINA (opseg ¢elija D3:D12), a potom uneti funkcije kao:

Na osnovu prethodnog primera progirite tabelu unosom podataka sa trzi$ta Sever i Jug (Insert Rows), a onda testiraj-
te primer izmenom vrednosti u kolonama B, C,DiG.

Treba uoditi da se funkcijom SUMIF ne moZe lako obezbediti uzajamna zavisnost viSe uslova (reSenje bi bilo vrlo
kompleksno), pa éemo takav problem resiti kod primene filtriranja podataka.
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[12] MS Excel

Grdfikoni

OSNOVE | PRIMENA

Grafikoni su &est pratilac statisti¢kih i tabelarnih prikaza rezultata, pa ¢esto mogu da ostave bolji utisak i od samih
podataka (nekada je vaZniji oblik predstavljanja podataka od njihovog kvaliteta). Ubacivanjem ovakvih grafickih
elemenata, Citaocu (ili posmatracu) se skrece paZnja, sa svega onoga $to bi se moglo videti, na ono $ta "treba" da vi-

di.

UNOS IZVORA PODATAKA | GRAFIKONA

Kreirajmo najpre tabelu (kao na slici ili sli¢nu).

Kada unesemo izvor podataka za grafikon, kliknemo u jednu éeliju tabele podataka, pa zatim na komandno dugme
Chart Wizard 8 na Standard paleti.

Dalje upravljanje procesom kreiranja grafikona je krajnje intuitivno i kreativno, pa ¢e vam predavac sugerisati §ta
treba da izaberete od svega ponudenog.

Na kraju kreiranja grafikona imate moguénost da:

1. grafikon ubacite kao novi radni list ili
2. kao graficki objekat istog radnog lista pored izvora podataka.

MODIFIKOVANJE GRAFIKONA

Grafikon moZe da se modifikuje u smislu poloZaja, veli¢ine, ugla zakoSenja (vaZi samo 3D tipove) boje svih vidljivih
elemenata, pa ¢ak i mu se moZe promeniti i tip. Formatizovanje nekog elementa se postiZe dvostrukim klikom u od-
nosni objekat, pa u dobijenom dijalogu izborom opcija. Tako se moze formatizovati: povrSine zidova, ose, ispis vred-
nosti po osama, legenda,...
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[13] MS Excel

Organizacija i obrada podataka

KaDA?

Grupa podataka se moze organizovati po nekom kriterijumu, tako da se u njoj mogu obavljati neke osnovne operaci-
je: uno$enje, uredivanje, analiza, izrada izveS§taja i sl. Kao primer nam moZe posluZiti jedan adresar kao ovaj.

SORTIRANJE

Sortiranje podataka podrazumeva njihovo uredivanje po odredenom redosledu, veli¢ini ili abecedno, §to MS Excel
omogucava preko dijaloga Sort na (Data» Sort), gde se moZe definisati trostepeno sortiranje (rastuce/opadajuée).
Izbor Sort By pokazuje sva polja tabele podataka. Ovde treba izabrati polje po kome se sortira, a zatim se izabrati ras-
tuéi (Ascending) ili opadajuéi (Descending) redosled sortiranja.
1. Unosi u sva polja Then By nisu obavezni. Oni omoguéavaju da se sortira po dva (ili tri) klju¢na
(polja).
2. MS Excel ée pokusati da utvrdi da li tabela ima naslovni red, a zatim prema tome postavlja pa-
rametar Header Row ili No Header Row. U drugom slu¢aju i prvi red tabele ulazi u sortiranje ($to
se ne preporucuje).

3. OK.

FlLTRlRAN]E PODATAKA
Filtriranje tabele podataka se koristi kada treba (u velikoj grupi podataka) treba videti jedan ili vise redova koji za-
dovoljavaju dati uslov, a ukljucuje se na Data» Filter» AutoFilter. Posle ovoga, svaka ¢elija u redu zaglavlja dobija
ComboBox iz kojeg se mo¥e odabrati:

1. (All) — prikaz svih vrednosti (iskljucuje filtriranje);

2. (Topl10...) —preko Cega se moZe izabrati nekoliko najveéih ili najmanjih vrednosti po odnosnoj

koloni;
3. (Custom...) — preko Cega se mogu traZiti podaci koji zadovoljavaju date uslove:

4. samo vrednost odabranu iz liste
(ako vise redova ima istu vrednost u toj koloni i oni ée biti prikazani).
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Izborom (Top 10...) moZemo videti nekoliko najvecih ili najmanjih vrednosti.

Na sledecoj slici dat je primer obracuna provizije za komercijaliste u firmi TALTEX Sistem, gde je od vise njih izab-
ran jedan i za njega automatski formirana suma vrednosti provizije na dovriene — Starih i novootvorene — Nowih du-
goro¢nih ugovora o zakupu, projektovanju i/ili prodaji.

PREGLED ZAPISA U FORMI

Kod unosa i pregleda sadrzaja podataka korisna je alatka kojom se svaki zapis prikazuje pojedinaéno, a dobija se pre-
ko Data» Form. Podaci se u ovom prikazu mogu aZurirati i pretraZivati, ¢ime se znatno povecava komfor u radu i ob-
jektivno stvaraju uslovi za povecanje njihove ta¢nosti.

Ovaj oblik obrade podataka je jo§ jedan prilog u odbrani principa da pri unosu veéih grupa podataka treba koristiti
kodni raspored CP1250 (latini¢ni), odnosno CP1252 (¢irili¢ni), jer ukoliko ste podatke u radni list unosili prema
kodnom rasporedu YUSCII, imaéete probleme jer se oni vide onako kako su i uneti (\@ ™).

Zadatak za verbu: PokuSajte da samostalno primenite obrazac i obracun koji je prikazan u prethodnom primeru,
primenjujuéi ono $to ste udili iz tema filtriranje i sumiranje.
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Zastita

KADA SE (NE)PRIMENJUJE

Nemojte da zapo&nete vase vezbe oko zastite radne knjige na nekom vaZnom radu, veé otvorite novu radnu knjigu,
unesite par Celija i proveZbajte sve redom. Mnogima se deSava da za$tite va¥an rad, pa pokusavsi da ga otvore posle
par dana, ustanove da nisu nigde zapisali $ifru koju su uneli.
Opsta pravila kod zadavanja §ifre su:

1. priunosu Sifre ispisuju se znaci "*" (zvezdice)

2. unos §ifre se mora ponoviti (radi kontrole),

3. usifri ne kombinujte velika i mala slova
4. ne unositi Sifru du?u od 6 do 8 karaktera
5

. ne koristite znake koji se razlikuju po poloZaju na drugim rasporedima tastature
(brojevi su univerzalni i preporucuju se)
6. ne unosite vase ime i imena ¢lanova vase porodice kao $ifre.

Dok budete veZbali zastitu vasih objekata u MS Excel-u koristite prednost koju nudi sam program, a to je da Sifre
uopite ne morate unositi da biste zaStitu postavili. Isto tako, §ifra vam nece trebati ni pri ukidanju postavljene zasti-
te. Tek kada dobro sagledate moguénosti i potrebe za zastitom podataka i objekata u Excel-u, moéi¢ete sami da se
odlugite §ta je potrebno zastititi, §ta ne.

ZASTITA CELIJE

U dijalogu Format Cells, na kartici Protection Eelija se moZe zastititi od izmena (Locked) ili od pogleda (Hidden), ali ¢e
zaStita Celije biti uzeta u obzir kada se zastiti i radni list.

ZASTITARADNOG LISTA

Radni list se $titi preko Tools» Protection» Protect Sheet, pa po otvaranju dijaloga (kao na slici desno) treba uneti $ifru
(nije obavezno). U zasti¢en radni list se ne moZe ubaciti (ni brisati) kolona, red, ¢elija, niti menjati njihova svojstva.

ZASTITARADNE KNJIGE

Zastita radne knjige podrazumeva zastitu redosleda i naziva radnih listova i definisanih opcija okruZenja, dobija se
na Tools» Protection» Protect Workbook i nije obavezna za unos.

ZASTITADATOTEKE

Ako na Save As dijalogu odaberemo komandno dugme Options, dobi¢emo dijalog za unos §ifre kao na slici:

gde moZemo uneti $ifru za otvaranje i $ifru za modifikovanje.
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